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1
Safety
This chapter contains:

• Notices and Safety... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

• Electrical Safety ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

• Operational Safety... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

• Maintenance Safety... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

• Printer Symbols ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

• Environmental, Health, and Safety Contact Information... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued and safe operation of
your Xerox printer.



Notices and Safety
Read the following instructions carefully before operating your printer. Refer to these instructions to
ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®
materials only.

Note: Unauthorized alterations, which can include the addition of new functions or the
connection of external devices, can affect the product certification. For more information,
contact your Xerox representative.
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Electrical Safety

GGeenneerraall GGuuiiddeelliinneess
WARNING:

• Do not push objects into slots or openings on the printer. Touching a voltage point or
shorting out a part could result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are installing
optional equipment and are instructed to do so. Turn off the printer when performing these
installations. Disconnect the power cord when removing covers and guards for installing
optional equipment. Except for user-installable options, there are no parts that you can
maintain or service behind these covers.

WARNING: The following are hazards to your safety:

• The power cord is damaged or frayed.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• The printer emits smoke, or the surface is unusually hot.

• The printer emits unusual noise or odors.

• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

PPoowweerr CCoorrdd
• Use the power cord supplied with your printer.

• Do not use an extension cord or remove or modify the power cord plug.

• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have
a ground connection terminal.

WARNING: Avoid the potential of electrical shock by ensuring that the printer is
grounded properly. Electrical products can be hazardous if misused.

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

• Do not place the printer in an area where people can step on the power cord.

• Do not place objects on the power cord.

• If the power cord becomes frayed or worn, replace it.

Xerox® WorkCentre® 3335/3345 Multifunction Printer
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• Do not plug or unplug the power cord while the power switch is in the On position.

• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power
cord.

• Ensure that the electrical outlet is near the printer and is easily accessible.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is
necessary to disconnect all electrical power from the printer, disconnect the power cord from the
electrical outlet.

EEmmeerrggeennccyy PPoowweerr OOffff
If any of the following conditions occur, power the printer off immediately. Disconnect the power cord
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if
any of the following occurs:

• The equipment emits unusual odors or makes unusual noises.

• The power cable is damaged or frayed.

• A wall panel circuit breaker, fuse, or other safety device has been tripped.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• Any part of the printer is damaged.

LLaasseerr SSaaffeettyy
This printer complies with laser product performance standards set by governmental, national, and
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous
light because the beam is enclosed completely during all modes of customer operation and
maintenance.

Laser Warning: Use of controls, adjustments, or performance of procedures other than those
specified in this manual can result in hazardous radiation exposure.
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Operational Safety
Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

OOppeerraattiioonnaall GGuuiiddeelliinneess
• Do not remove any paper trays while the printer is printing.

• Do not open the doors when the printer is printing.

• Do not move the printer when it is printing.

• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

Hot Warning: The metallic surfaces in the fuser area are hot. Always use caution when
removing paper jams from this area and avoid touching any metallic surfaces.

OOzzoonnee RReelleeaassee
This printer produces ozone during normal operation. The amount of ozone produced depends on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to one of the following:

• WorkCentre® 3335: www.xerox.com/environment

• WorkCentre® 3345: www.xerox.com/environment

In other markets, contact your local Xerox representative or go to one of the following:

• WorkCentre® 3335: www.xerox.com/environment_europe

• WorkCentre® 3345: www.xerox.com/environment_europe
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PPrriinntteerr LLooccaattiioonn
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.

To find the weight for your printer configuration, refer to Physical Specifications.

• Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

• Place the printer in an area where there is adequate space for operation and servicing.

• Place the printer in a dust-free area.

• Do not store or operate the printer in an extremely hot, cold, or humid environment.

• Do not place the printer near a heat source.

• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

• Do not place the printer where it is exposed directly to the cold air flow from an air conditioning
system.

• Do not place the printer in locations that are susceptible to vibrations.

• For optimum performance, use the printer at the elevations specified in Elevation.

PPrriinntteerr SSuupppplliieess
• Use supplies that are designed for your printer. The use of unsuitable materials can cause poor

performance and a possible safety hazard.

• Follow all warnings and instructions marked on, or supplied with the product, options, and
supplies.

• Store all consumables in accordance with the instructions provided on the package or container.

• Keep all consumables away from the reach of children.

• Never throw toner, print cartridges, drum cartridges, or toner containers into an open flame.

• When handling cartridges, such as toner cartridges, avoid skin or eye contact with toner. Eye
contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge,
which can increase the risk of skin or eye contact.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies
not specified for this printer. The Total Satisfaction Guarantee is available in the United States
and Canada. Coverage could vary outside these areas. For details, contact your Xerox
representative.
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Maintenance Safety
• Do not attempt to perform any maintenance procedure that is not described specifically in the

documentation supplied with your printer.

• Do not use aerosol cleaners. Clean with a dry lint-free cloth only.

• Do not burn any consumables or routine maintenance items.

• For information on Xerox supplies recycling programs, go to one of the following:

– WorkCentre® 3335: www.xerox.com/gwa

– WorkCentre® 3345: www.xerox.com/gwa

WARNING: Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when
used on electromechanical equipment.
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Printer Symbols
Symbol Description

Warning:

Indicates a hazard that can cause serious injury or death if not
avoided.

Hot Warning:

Hot surface on or in the printer. Use caution to avoid personal
injury.

Caution:

Indicates a mandatory action to take to avoid damage to the
property.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the drum cartridges.

Do not touch the part or area of the printer.
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Symbol Description

Do not use paper attached with staples or any other form of
binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not load or use inkjet paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.

Add paper or media.

Paper jam

Lock

Xerox® WorkCentre® 3335/3345 Multifunction Printer
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Symbol Description

Unlock

Document

Paper

WLAN

Wireless Local Area Network

LAN

Local Area Network

USB

Universal Serial Bus

Telephone Line

Modem Line

Postcard

Load envelopes in the tray with the flaps closed and facing up.
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Symbol Description

Load envelopes in the tray with the flaps open and facing up.

NFC

Near Field Communication

Weight

Data Transmission

Paper Feeding Direction Indicator

Symbol Description

Start Button

Stop Button

Pause Printing Button

Login In/Out Button

Help Button
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Symbol Description

Services Home Button

Services Button

Job Status Button

Printer Status Button

Language Button

Power/Wake Button

Clear All Button

Clear Button

Dial Pause/Redial Button

This item can be recycled. For details, refer to Recycling and
Disposal.
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Environmental, Health, and Safety Contact
Information
For more information on Environment, Health, and Safety in relation to this Xerox product and
supplies, contact the following customer help lines:

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Europe: +44 1707 353 434

For product safety information in the United States, go to one of the following:

• WorkCentre® 3335: www.xerox.com/environment

• WorkCentre® 3345: www.xerox.com/environment

For product safety information in Europe, go to one of the following:

• WorkCentre® 3335: www.xerox.com/environment_europe

• WorkCentre® 3345: www.xerox.com/environment_europe
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Parts of the Printer
FFrroonntt VViieeww

1. Optional Feeder Tray 2 with 550-Sheet
Capacity

2. Tray 1 with 250-Sheet Capacity

3. Bypass Tray

4. Output Tray

5. Control Panel

6. Card Reader Bay for optional NFC
Enablement Kit

7. Document Feeder Top Cover

8. Document Feeder Input Tray

9. Document Feeder Output Tray

10. USB Port

11. Control Board Cover
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DDooccuummeenntt FFeeeeddeerr
The WorkCentre 3335® uses an Automatic Document Feeder (ADF).

The WorkCentre 3345® uses a Reversing Automatic Document Feeder (RADF).

RReeaarr VViieeww

1. Power Receptacle

2. Power Switch

3. USB Port for Service only

4. Network Port

5. USB Port

6. Telephone Line Socket

7. Extension Telephone Socket

8. Rear Door

9. Duplex Unit
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IInntteerrnnaall CCoommppoonneennttss

1. Drum Cartridge

2. Toner Cartridge

3. Document Glass

4. Document Glass Cover

5. Document Feeder
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CCoonnttrrooll PPaanneell
The control panel consists of a touch screen and buttons that you press to control the functions
available on the printer. You can use the control panel to perform the following tasks:

• View the current operating status of the device

• Access printer features

• Access reference materials

• Access the Tools and Setup menus

• Access the Troubleshooting menus and videos

• View status messages about paper tray levels and supplies

• View any errors or warnings that occur on the device

Item Name Description

1 Machine Status Button This button displays the status of the printer on the touch screen.

2 Job Status Button This button displays all active, secure, or completed jobs on the touch
screen.

3 Services Button This button returns you to the active service from the Job Status or
Machine Status screens, or to a preset service.

4 Services Home Button This button provides access to printer features such as copy, scan,
and fax on the touch screen.

5 Touch Screen Display The screen displays information and provides access to printer
functions.

6 Log In/Out Button This button provides access to password-protected features.

7 Help Button This button displays information about the current selection on the
touch screen.

8 Language Button This button changes the touch screen language and keyboard
settings.

9 Power Saver button This button enters and exits the low-power mode.

10 Clear All Button This button clears previous and changed settings for the current
selection. To reset all features to their default settings and clear
existing scans, press this button twice.
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Item Name Description

11 Stop Button This button stops the current job temporarily. To cancel or resume
your job, follow the onscreen instructions.

12 Start Button This button starts the selected copy, scan, fax, or Print From job, such
as Print from USB.

13 Interrupt Button This button pauses the current job to run a more urgent print, copy,
or fax job.

14 Dial Pause Button This button inserts a pause in a telephone number when the printer
transmits a fax.

15 C (clear) Button This button deletes numeric values or the last digit entered using the
alphanumeric keys.

16 Alphanumeric Keypad Use the keypad to enter alphanumeric information.
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Information Pages
Your printer has a set of information pages that you can access from the control panel touch screen.
These information pages include Customer Support access, installed options, and more.

AAcccceessssiinngg aanndd PPrriinnttiinngg tthhee IInnffoorrmmaattiioonn PPaaggeess
To access the full list of information pages for your printer:

1. At the printer control panel, press the Help button.

A list of information pages that you can print appears.

2. To scroll through the list of available pages, touch and drag your finger up or down on the menu.
Touch the desired page, then touch Print.

Note: To print all of the information pages, at the bottom of the list, touch All Information
Pages, then touch Print.

3. To return to the Home screen, touch (X).

PPrriinnttiinngg tthhee CCoonnffiigguurraattiioonn RReeppoorrtt aatt tthhee CCoonnttrrooll
PPaanneell
The Configuration Report provides product information including installed options, network settings,
port setup, tray information, and more.

Note: To turn off automatic printing of a Configuration Report, refer to Setting Access Rights
for the Configuration Report and Information Pages.

1. At the printer control panel, press the Help button.

2. Touch System Configuration Report.

3. Touch Print.

4. To return to the Services Home menu, press the Services Home button.
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Administration Features
For details, refer to the System Administrator Guide:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs

XXeerrooxx®® CCeennttrreeWWaarree®® IInntteerrnneett SSeerrvviicceess
Xerox® CentreWare® Internet Services is the administration and configuration software installed on
the embedded Web server in the printer. It allows you to configure and administer the printer from a
Web browser.

Xerox® CentreWare® Internet Services requires:

• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

• TCP/IP and HTTP enabled in the printer.

• A network-connected computer with a Web browser that supports JavaScript.

AAcccceessssiinngg XXeerrooxx®®CCeennttrreeWWaarree®® IInntteerrnneett SSeerrvviicceess
1. At your computer, open a Web browser.

2. In the address field, type the IP address of the printer.

3. Press Enter or Return.

LLooccaattiinngg tthhee IIPP AAddddrreessss ooff tthhee PPrriinntteerr
You can view the IP address of your printer on the control panel or on the Configuration Report.

To install print drivers for a network-connected printer, you need the IP address of your printer. You
need the IP address to access and configure any printer settings in Xerox® CentreWare® Internet
Services.

1. To view the IP address of the printer on the control panel:

a. At the printer control panel, press the Machine Status button.

b. Touch the Machine Information tab.
If the system administrator has set the display network settings to show the IP address, the
address appears at the top of the Machine Information list.

Note: If the IP address does not appear, print the Configuration Report or contact your
system administrator.

2. To print a Configuration Report, perform the following steps:

a. At the printer control panel, press the Help button.

b. Touch System Configuration Report.
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c. Touch Print.

Note: After the printer has been powered on for 2 minutes, print the Configuration
Report.

• The TCP/IP address appears in the Network Setup section of the page.

• If the IP address that appears on the page is a system default address, such as
169.254.xxx.xxx, the printer did not acquire an IP address from the DHCP server.

• Wait 2 minutes, then print the Configuration Report again.

• After 2 minutes, if the IP address does not appear, contact the system
administrator.

d. To close the window, touch X.

AAuuttoommaattiicc DDaattaa CCoolllleeccttiioonn
The printer collects data automatically and transmits the information to a secure off-site location.
Xerox or a designated service provider uses this data to support and service the printer, or for billing,
supplies replenishment, or product improvement. Automatically transmitted data can include product
registration, meter readings, supplies levels, printer configuration and settings, software version, and
problem or fault-code data. Xerox cannot read, view, or download the content of your documents that
reside on or pass through your printer or any of your information-management systems.

To disable automatic data collection:

1. At your computer, open a Web browser.

2. In the address field, type the IP address of the printer.

3. Press Enter or Return.

4. On the Xerox® CentreWare® Internet Services Welcome page, select the link in the note regarding
automated services.

Selecting this link opens the SMart eSolutions Setup page in Xerox® CentreWare® Internet
Services. From this page, select Not Enrolled→Apply.

Note: Administrator credentials are required to disable SMart eSolutions. If you do not
have administrator credentials, contact the administrator for the printer.

MMaaiinntteennaannccee AAssssiissttaanntt
Your printer includes a built-in diagnostic capability allowing you to send diagnostic information
directly to Xerox. Maintenance Assistant is a remote diagnostic tool that offers a fast way to resolve
potential issues, receive assistance, and automate the troubleshooting or repair process.

EEnnaabblliinngg MMaaiinntteennaannccee AAssssiissttaanntt
Before you begin: If your network uses a proxy server, configure the Proxy Server settings of the
printer to ensure that the printer can connect to the Internet.

1. From the Printer Status window, click Help→Xerox®CentreWare® Internet Services.

2. From Xerox®CentreWare®Internet Services, click Status→SMart eSolutions.

3. From Smart eSolutions, click Maintenance Assistant.
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4. To send status information to Xerox, click Start an Online Troubleshooting Session at www.
Xerox.com.

5. After the data is sent, your browser is redirected to www.xerox.com to start your online
troubleshooting session.

BBiilllliinngg aanndd UUssaaggee IInnffoorrmmaattiioonn
Billing and printer usage information appears on the Billing Meters information screen. The
impression counts shown are used for billing. For details on viewing this information, refer to Billing
and Usage Information in the Maintenance chapter.
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More Information
You can obtain more information about your printer from these sources:

Resource Location

Installation guide The installation guide is packaged with the printer. To
download the installation guide, select the link for your printer:
• www.xerox.com/office/WC3335docs
• www.xerox.com/office/WC3345docs

Other documentation for your printer • www.xerox.com/office/WC3335docs
• www.xerox.com/office/WC3345docs

Technical support information for your printer,
including online technical support, Online
Support Assistant, and driver downloads.

• www.xerox.com/office/WC3335support
• www.xerox.com/office/WC3345support

Information about menus or error messages Press the control panel Help (?) button.

Information Pages Print information pages from the control panel, or from Xerox®
CentreWare® Internet Services, select
Properties→Services→Printing→Reports.

Xerox® CentreWare® Internet Services
documentation

From Xerox® CentreWare® Internet Services, select Help.

Order supplies for your printer • www.xerox.com/office/WC3335supplies
• www.xerox.com/office/WC3345supplies

A resource for tools and information,
including interactive tutorials, printing
templates, helpful tips, and customized
features to meet your individual needs.

www.xerox.com/office/businessresourcecenter

Local sales and support center • WorkCentre® 3335: www.xerox.com/office/worldcontacts
• WorkCentre® 3345: www.xerox.com/office/worldcontacts

Printer registration • WorkCentre® 3335: www.xerox.com/office/register
• WorkCentre® 3345: www.xerox.com/office/register

Xerox® Direct online store www.direct.xerox.com/
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Installation and Setup Overview
Before printing, ensure that your computer and the printer are plugged in, turned on, and connected.
Configure the initial settings of the printer. On your computer, install the driver software and utilities
on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB
cables are not included with your printer and must be purchased separately. Xerox recommends an
Ethernet connection because, typically, it is faster than a USB connection, and it provides access to
Xerox® CentreWare® Internet Services.

Note: If the Software and Documentation disc is not available, you can download the latest
drivers at:

• www.xerox.com/office/WC3335drivers

• www.xerox.com/office/WC3345drivers

Related Topics:
Selecting a Location for the Printer
Selecting a Connection Method
Connecting the Printer
Configuring Network Settings
Installing the Software
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Selecting a Location for the Printer
• Select a dust-free area with temperatures from 10–30° C (50–90° F), and relative humidity 20–

80%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a
cold room can cause condensation inside the printer, directly interfering with image
transfer.

• Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of
the printer. The printer must be horizontal with all four feet in solid contact with the surface. To
find the weight for your printer configuration, refer to Physical Specifications.

• Select a location with adequate clearance to access supplies and to provide proper ventilation. To
find the clearance requirements for your printer, refer to Clearance Requirements for Standard
Configuration.

• After positioning the printer, you are ready to connect it to the power source and computer or
network.
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Connecting the Printer

SSeelleeccttiinngg aa CCoonnnneeccttiioonn MMeetthhoodd
The printer can be connected to your computer using a USB cable or an Ethernet cable. The method
you select depends on how your computer is connected to the network. A USB connection is a direct
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are
using a network connection, ensure that you understand how your computer is connected to the
network. For details, refer to About TCP/IP and IP Addresses.

Note:

• Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

• Hardware and cabling requirements vary for the different connection methods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not included
with your printer and must be purchased separately.

Network

If your computer is connected to an office network or home network, use an Ethernet cable to
connect the printer to a network port. Ethernet networks can support many computers, printers, and
devices simultaneously. In most cases, Ethernet connection is faster than USB and provides direct
access to printer settings using Xerox® CentreWare® Internet Services.

Wireless Network

If your network includes a wireless router or wireless access point, you can connect the printer to the
network with a wireless connection. A wireless network connection provides the same access and
services as a wired connection provides. A wireless network connection is typically faster than USB
and allows direct access to the setting of the printer using Xerox® CentreWare® Internet Services.

USB

If you connect the printer to one computer and do not have a network, use a USB connection. A USB
connection offers fast data speeds, but typically not as fast as an Ethernet connection. In addition, a
USB connection does not provide access to Xerox® CentreWare® Internet Services.

Telephone

To send and receive faxes, the multifunction printer must be connected to a dedicated telephone line.
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CCoonnnneeccttiinngg tthhee PPrriinntteerr ttoo tthhee NNeettwwoorrkk
Use a Category 5 or higher Ethernet cable to connect the printer to the network. An Ethernet network
is used for one or more computers and supports many printers and systems simultaneously. An
Ethernet connection provides direct access to printer settings using Xerox® CentreWare® Internet
Services.

To connect the printer:

1. Ensure that the printer is powered off.

2. Connect one end of a Category 5 or higher Ethernet cable to the Ethernet port on the printer.
Connect the other end of the Ethernet cable to a correctly configured network port on a hub or
router.

3. Connect the power cord to the printer, and plug the cord into an electrical outlet.

4. Turn on the printer.
For details on configuring network settings, refer to the System Administrator Guide at:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs

5. Enter the printer IP address or set Xerox® CentreWare® Internet Services to automatically
discover the network IP address of the printer.

CCoonnnneeccttiinngg ttoo aa CCoommppuutteerr UUssiinngg UUSSBB
To connect using USB, you need Windows 7, Windows 8 or later, Windows Server 2008 or later, or
Macintosh OS X version 10.9 or later.

To connect the printer to the computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the front, right side of the
printer.

2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, select Cancel.

4. Install the print drivers. For details, refer to Installing the Software.

CCoonnnneeccttiinngg ttoo aa TTeelleepphhoonnee LLiinnee
Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

1. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

2. Connect the other end of the RJ11 cable to an operating telephone line.

3. Enable and configure the Fax functions.

For details, refer to the System Administrator Guide at:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs
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PPoowweerriinngg OOnn oorr OOffff tthhee PPrriinntteerr
Before powering on the printer, ensure that the power cord is plugged into the printer and wall outlet,
and that the power switch is in the off position.
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The printer has a power Down button on the touch screen and a power switch on the back-left side.

• The power down button initiates an orderly shutdown of the printer electronic components.

• The power switch controls the main power to the printer.

.

1. To power on the printer, press the power switch to the On position.

Note: If the power switch is on, but the printer is powered off, the printer was turned off
using the control panel. To power on the printer, press the power switch to the Off position
first, then press the power switch to the On position.

2. To turn off the printer:

Caution:

• To prevent a printer malfunction, perform the control panel shutdown first.

• Do not plug or unplug the power cord while the printer is powered on.

a. At the printer control panel, press the Power Saver button.

b. Touch Power Down.

Note: When all of the control panel lights are off, the printer power-off sequence is
complete. Pressing the power switch off is optional.
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Configuring Network Settings

AAbboouutt TTCCPP//IIPP aanndd IIPP AAddddrreesssseess
Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network.
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour
does not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server
automatically assigns an IP address to every computer and printer on the network that is configured
to use DHCP.

If you use a cable or DSL router, for information on IP addressing, refer to the documentation for your
router.
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Enabling the Printer for Scanning
If the printer is connected to a network, you can scan to any of the following locations.

• FTP

• SMB

• HTTP

• HTTPS

• SFTP

• An email address

• A shared folder on your computer

For details, refer to Xerox® CentreWare® Internet Services.

Note: If your printer is connected using the USB cable, you cannot scan to an email address or
a network location, such as a shared folder on your computer.

For details, refer to the System Administrator Guide at:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs
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Power Saver Mode
Power Saver mode reduces power consumption when the printer is left idle for a specified period.

PPoowweerr SSaavveerr LLeevveellss
There are two levels of Power Saver mode.

• Power Saver Mode 1: After a specified period of inactivity, the touch screen dims and the printer
operates on reduced power consumption.

• Power Saver Mode 2: After a specified period of inactivity, the touch screen turns off and the
printer enters standby mode.

EExxiittiinngg PPoowweerr SSaavveerr MMooddee
The printer exits Power Saver mode automatically when any of the following events occur:

• Pressing a button on the control panel

• Touching the UI screen

• Receiving data from a connected device

• Opening any door or cover on the printer

SSeettttiinngg tthhee PPoowweerr SSaavveerr MMooddee TTiimmeerrss aatt tthhee CCoonnttrrooll
PPaanneell

Note: You must have administrator credentials to perform the following procedure. If you do
not have administrator credentials, contact the printer administrator.

1. At the printer control panel, press the Machine Status button.

2. Touch Device Settings→General→Power Saver Timer.

3. To select the desired time, press the arrow buttons, or enter a value using the numeric keypad.
• Specify how long the printer remains idle before it goes from ready mode to low-power mode.
• Specify how long the printer remains idle before automatically going from low-power mode to

sleep mode.

4. Touch OK.

44 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Installation and Setup



Installing the Software
Before you install driver software, verify that the printer is plugged in, turned on, connected correctly,
and has a valid IP address. If you cannot find the IP address, refer to Locating the IP Address of the
Printer.

If the Software and Documentation disc is not available, download the latest drivers at:

• www.xerox.com/office/WC3335drivers

• www.xerox.com/office/WC3345drivers

OOppeerraattiinngg SSyysstteemm RReeqquuiirreemmeennttss
• Windows Vista, Windows 7, Windows 8, Windows 8.1, Windows 10, Windows Server 2008,

Windows Server 2008 R2, and Windows Server 2012

• Macintosh OS X version 10.9 and later

• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface. For details, refer to:

– www.xerox.com/office/WC3335drivers

– www.xerox.com/office/WC3345drivers

IInnssttaalllliinngg DDrriivveerrss aanndd UUttiilliittiieess ffoorr WWiinnddoowwss
To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:

1. Insert the Software and Documentation disc into the appropriate drive on your computer. The
installer starts automatically.
If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

2. To change the language, click Language.

3. Select your language, then click OK.

4. Click Install Drivers→Install Print and Scan Drivers.

5. To accept the license agreement, click I Agree.

6. From the list of discovered printers, select your printer, then click Next.

7. If your printer does not appear in the list of discovered printers, click Extended Search.

8. If your printer still does not appear in the list of discovered printers, and you know the IP address,
choose one of the following:
• At the top of the window, click the Network Printer icon, and enter the IP address or the DNS

name of the printer.
• Click Search, and from the list of discovered printers, select your printer, then click Next.

9. If the printer still does not appear in the list of discovered printers, and you do not know the IP
address:

a. Click Advanced Search.
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b. If you know the gateway address and subnet mask, click the top button and enter the
addresses into the Gateway and Subnet Mask fields.

c. If you know the address of another printer on the same subnet, click the middle button and
enter the address in the IP Address field.

d. Click Search.

e. From the list of discovered printers, select your printer, then click Next.

Note: When the printer appears in the Discovered Printers window, it displays the IP
address. Record the IP address for future use.

10. Select the desired driver.

11. Click Install.

12. If the installer prompts you for the IP address, enter the IP address of the printer.

13. If the installer prompts you to restart your computer, click Restart to complete the installation of
the drivers.

14. To complete the installation, click Finish.

IInnssttaalllliinngg PPrriinntt DDrriivveerrss ffoorr MMaacciinnttoosshh OOSS XX VVeerrssiioonn
1100..99 aanndd LLaatteerr
Use this procedure to install the Xerox print driver to access all features of your printer.

To install the print driver software:

1. Insert the Software and Documentation disc into the appropriate drive on your computer.

2. To view the .dmg file for your printer, on your desktop, click the disc icon.

3. Open the .dmg file, then navigate to the appropriate installer file for your operating system.

4. To begin installation, open the Installer package file.

5. To acknowledge the warning and introductory messages, click Continue. Click Continue again.

6. To accept the license agreement, click Continue, then click Agree.

7. To accept the current installation location, click Install, or select another location for the
installation files, then click Install.

8. Enter your password, then click Install Software.

9. Select your printer in the list of discovered printers, then click Continue. If your printer does not
appear in the list of discovered printers:

a. Click the Network Printer icon.

b. Type the IP address of your printer, then click Continue.

c. Select your printer in the list of discovered printers, then click Continue.

10. To accept the print queue message, click Continue.

11. To accept the installation success message, click Close.

12. To verify that the print driver recognizes the installed options:

a. From the Apple menu, click System Preferences→Printers and Scanners.
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b. Select the printer from the list, then click Options & Supplies.

c. Click Options.

d. Confirm that all of the options installed on the printer appear correct.

e. If you change settings, click OK, close the window, then exit System Preferences.

IInnssttaalllliinngg SSccaann DDrriivveerrss ffoorr MMaacciinnttoosshh
To install the scan driver software:

1. To download the latest driver, go to:
• www.xerox.com/office/WC3335drivers
• www.xerox.com/office/WC3345drivers

2. Download the appropriate package for your operating system.

3. To view the .dmg file for your printer, on your desktop, click the disc icon.

4. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your
operating system.

5. Open the Scan Installer package file.

6. To acknowledge the warning and introductory messages, click Continue.

7. To accept the license agreement, click Continue, then click Agree.

8. Click Continue again.

9. Enter your password, then click OK.

10. If prompted to close other installations, click Continue Installing.

11. To restart, click Log Out.

IInnssttaalllliinngg tthhee PPrriinntt DDrriivveerrss ffoorr UUNNIIXX aanndd LLiinnuuxx
Note:

• To install the UNIX print drivers on your computer, root or superuser privileges are required.

• This procedure requires an Internet connection.

To install Linux drivers, perform the following steps, then select Linux instead of UNIX for the
operating system and package.

To install the print driver software:

1. On the printer control panel, for the IP address, do the following:

a. Allow the printer to set up a DHCP address.

b. Print the Configuration Report and keep it for reference.
For details on how to print the Configuration Report, refer to Printing the Configuration
Report at the Control Panel.

c. From the Configuration Report, verify that the TCP/IP protocol is enabled and the network
cable is installed.

2. At your computer, do the following:
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a. From the print driver website for your printer, select your printer model.

b. From the Operating System menu, select UNIX, then click Go.

c. Select the appropriate package for your operating system.

d. To begin downloading, click the Start button.

3. In the notes below the driver package that you selected, click the Installation Guide link, then
follow the installation instructions.

OOtthheerr DDrriivveerrss
The following drivers are available for download:

• The Xerox® Global Print Driver works with any printer on your network, including those printers
made by other manufacturers. At installation, it configures itself for your individual printer upon
installation.

• The Xerox® Mobile Express Driver works with any printer available to your computer that supports
standard PostScript. Each time you select Print, it configures itself for the correct printer. If you
travel frequently to the same sites, you can save your favorite printers in that location and the
driver saves your settings.

Download the drivers at:

• www.xerox.com/office/WC3335drivers

• www.xerox.com/office/WC3345drivers
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Installing the Printer as a Web Service on
Devices
Web Services on Devices (WSD) allow a client to discover and access a remote device and its
associated services across a network. WSD supports device discovery, control, and use.

1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Device Wizard, click Add a Device.

3. In the list of available devices, select the one you want to use, then click Next.

Note: If the printer you want to use does not appear in the list, click the Cancel button.
Add the WSD printer manually using the Add Printer Wizard; for details, refer to Installing a
WSD Printer Manually Using the Add Printer Wizard.

4. Click Close.
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Installing a WSD Printer Manually Using the
Add Printer Wizard
1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Printer Wizard, click Add a Printer.

3. Click Add a network, wireless, or Bluetooth printer.

4. In the list of available devices, select the one you want to use, then click Next.

5. If the printer that you want does not appear in the list, click The printer that I want is not listed.

6. Select Add a printer using a TCP/IP address or hostname, then click Next.

7. For the Device type field, select Web Services Device.

8. In the Hostname or IP address field, enter the printer IP address. Click Next.

9. Select an option for sharing the printer with others in your network.

10. To identify the printer for sharing, enter a share name, location, and comments to identify the
printer. Click Next.

11. To set the printer as the default, select an option. To test the connection, click Print a Test Page.

12. Click Finish.
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AirPrint, Mopria, Google Cloud Print, and NFC
The following allow you to print without requiring a print driver:

AirPrint
Use AirPrint to print from a wired or wireless device directly without using a print driver. AirPrint is
a software feature that allows you to print from wired or wireless Apple iOS-based mobile devices
and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers allow
you to print or fax directly from a Mac, an iPhone, iPad, or iPod touch.

Mopria
Mopria is a software feature that enables users to print from mobile devices without requiring a
print driver. You can use Mopria to print from your mobile device to Mopria-enabled printers.

Google Cloud Print
Google Cloud Print allows you to print documents from an Internet-connected device without
using a print driver. Documents stored in the cloud, a personal computer, tablet, or smartphone
can be sent to the printer from anywhere.

NFC (Near Field Communication)
Near field communication (NFC) is a technology that enables devices to communicate when they
are within 10 centimeters of each other. You can use NFC to obtain the network interface to
establish a TCP/IP connection between your device and the printer.

For more information, refer to the System Administrator Guide:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs
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Supported Paper
Your printer is designed to use various paper and other media types. To ensure the best print quality
and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

OOrrddeerriinngg PPaappeerr
To order paper or other media, contact your local reseller or visit:

• www.xerox.com/office/WC3335supplies

• www.xerox.com/office/WC3345supplies

GGeenneerraall PPaappeerr LLooaaddiinngg GGuuiiddeelliinneess
• Fan paper before loading it in the paper tray.

• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

• Adjust the paper guides to fit the paper size.

• If excessive jams occur, use paper or other approved media from a new package.

• Do not print on label media after a label has been removed from a sheet.

• Use only paper envelopes.

• Print envelopes 1-sided only.

PPaappeerr TThhaatt CCaann DDaammaaggee YYoouurr PPrriinntteerr
Some paper and other media types can cause poor output quality, increased paper jams, or can
damage your printer. Do not use the following paper types:

• Rough or porous paper

• Inkjet paper

• Non-laser glossy or coated paper

• Paper that has been photocopied

• Paper that has been folded or wrinkled

• Paper with cutouts or perforations

• Stapled paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Plastic media

Caution: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee
does not cover damage caused by using unsupported paper or specialty media. The Xerox®
Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary
outside these areas. For details, contact your local Xerox representative.
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PPaappeerr SSttoorraaggee GGuuiiddeelliinneess
Storing paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.

• Maintain constant temperatures and relative humidity.

• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

• Store paper flat, either on pallets, cartons, shelves, or in cabinets.

• Avoid food or drinks in the area where paper is stored or handled.

• Do not open sealed packages of paper until you are ready to load the paper into the printer.
Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture
loss or gain.

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag
until you are ready to use it. Keep unused media in the bag and reseal it for protection.

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss

Trays Paper Types Weights

Bypass and

Trays 1 and 2
Plain

Letterhead

Pre-printed

Hole-Punched

Lightweight

Heavyweight

Cardstock

Bond

Recycled

Archival

70–85 g/m2

70–85 g/m2

70–85 g/m2

70–85 g/m2

60–70 g/m2

85–105 g/m2

106–163 g/m2

105–120 g/m2

60–85 g/m2

Not Applicable

Bypass Tray and Tray 1
only Transparency Not Applicable

Bypass Tray only Labels

Envelope

Custom

120–150 g/m2

75–90 g/m2

60–220 g/m2

Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

55

Paper and Media



SSuuppppoorrtteedd SSttaannddaarrdd PPaappeerr SSiizzeess

Tray European Standard Sizes North American Standard Sizes

Bypass and Trays 1 and
2

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)

JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)

ISO B5 (176 x 250 mm, 6.9 x 9.8 in.)

A6 (105 x 148 mm, 4.1 x 5.8 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Oficio (216 x 343 mm, 8.5 x 13.5 in.)

Folio (216 x 330 mm, 8.5 x 13 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

Statement (140 x 216 mm, 5.5 x 8.5 in.)

Bypass Tray only C5 envelope (162 x 229 mm, 6.4 x 9 in.)

C6 envelope (114 x 162 mm, 4.5 x 6.38 in.)

DL envelope (110 x 220 mm, 4.33 x 8.66 in.)

Index Card (76.2 x 127 mm, 3 x 5 in.)

Postcard (100 x 148 mm, 3.94 x 5.83 in.)

Postcard (102 x 152 mm, 4 x 6 in.)

No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)

No. 9 envelope (114 x 162 mm, 4.5 x 6.38 in.)

Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.)

Index Card (76.2 x 127 mm, 3 x 5 in.)

SSuuppppoorrtteedd CCuussttoomm PPaappeerr SSiizzeess
Tray Width Length

Bypass Tray 98–216 mm (3.9–8.5 in.) 148–356 mm (5.8–14 in.)

Trays 1 and 2 105–216 mm (4.1–8.5 in.) 148–356 mm (5.8–14 in.)

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss ffoorr AAuuttoommaattiicc 22--
SSiiddeedd PPrriinnttiinngg

Paper Types Weights

Lightweight 60–70 g/m2

Recycled 60–85 g/m2

Plain

Letterhead

Hole-Punched

Pre-printed

70–85 g/m2
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Paper Types Weights

Heavyweight 86–105 g/m2

Bond 105–120 g/m2

SSuuppppoorrtteedd SSttaannddaarrdd PPaappeerr SSiizzeess ffoorr AAuuttoommaattiicc 22--
SSiiddeedd PPrriinnttiinngg

European Standard Sizes North American Standard Sizes

A4 (210 x 297 mm, 8.3 x 11.7 in.) Letter (216 x 279 mm, 8.5 x 11 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Oficio (216 x 343 mm, 8.5 x 13.5 in.)

Folio (216 x 330 mm, 8.5 x 13 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

SSuuppppoorrtteedd CCuussttoomm PPaappeerr SSiizzeess ffoorr AAuuttoommaattiicc 22--SSiiddeedd
PPrriinnttiinngg
Source Media Types Sizes Thickness

Tray 1 or 2 Plain, Lightweight,
Heavyweight, Bond,
Cardstock, Recycled, Archive

A4, Letter, Legal, Executive,
Folio, Oficio, ISO B5, JIS B5,
A5, A6

60–163 g (16–43 lb.)

Bypass Tray Plain, Lightweight,
Heavyweight, Bond,
Cardstock, Cotton, Colored,
Pre-Printed, Recycled, Archive,
Transparency, Label

A4, Letter, Legal, Executive,
Folio, Oficio, ISO B5, JIS B5,
A5, A6, 3 in. x 5 in.

60–220 g (16–58 lb.)

Envelope Monarch, No.10, DL, C5, C6

Cardstock International Post Card

Custom minimum size: 75 mm width
x 125 mm length 2.95 in.
width x 4.92 in. length)

Duplex Plain, Lightweight,
Heavyweight, Bond, Recycled

A4, Letter, Legal, Folio, Oficio 60–120 g (16–32 lb.)
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Loading Paper

LLooaaddiinngg PPaappeerr iinn tthhee BByyppaassss TTrraayy
To load paper in the bypass tray:

1. Open the bypass tray.

Note: If the bypass tray is open and loaded with paper already, remove any paper that is a
different size or type.

a. To open the bypass tray, press the cover.
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b. Extend the bypass tray fully.
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2. Move out the length and width guides.
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3. Flex the sheets of paper back and forth and fan the sheets. On a level surface, align the edges of
the paper stack. This procedure separates any sheets that are stuck together and reduces the
possibility of jams.

Note: To avoid paper jams and misfeeds, do not remove paper from the packaging until
you are ready to use the paper.
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4. Load the paper in the tray, then adjust the width guides until they touch the edges of the paper.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause paper
jams.

• Load hole-punched paper with the holes toward the left side of the printer.
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• For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face
up with the top edge going into the printer first.
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5. If the control panel Paper Settings screen prompts you, verify the paper size, type, and color.

6. Touch Confirm.
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LLooaaddiinngg PPaappeerr iinn TTrraayy 11
Tray 1 holds a maximum of 250 sheets of paper.

1. Pull out and remove the tray.

2. Move out the length and width guides.

a. Pinch the guide lever on each guide.

b. Slide out the guides until they stop.

c. Release the levers.
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3. Flex the sheets of paper back and forth and fan the sheets. On a level surface, align the edges of
the paper stack. This procedure separates any sheets that are stuck together and reduces the
possibility of paper jams.
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4. Load the paper into the tray as shown, then adjust the paper guides in the tray to match the size
of the paper.

• Load paper into the tray with the print side face down.

• Load hole-punched paper with the holes toward the right side of the printer.

• Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams.
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5. Slide the tray into the printer and push in the tray until it stops.

6. If the control panel Paper Settings screen prompts you, verify the paper size, type, and color.

7. Touch Confirm.
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LLooaaddiinngg PPaappeerr iinn OOppttiioonnaall TTrraayy 22
Tray 2 holds a maximum of 550 sheets of paper.

1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray
slightly, then pull out the tray.

2. Move out the length and width guides.

a. Pinch the guide lever on each guide.

b. Slide out the guides until they stop.

c. Release the levers.
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3. Flex the sheets back and forth and fan the paper. On a level surface, align the edges of the paper
stack. This procedure separates any sheets that are stuck together and reduces the possibility of
paper jams.
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4. Load the paper into the tray as shown. Adjust the paper guides in the tray to match the size of
the paper.

• Load paper into the tray with the print side face down.

• Load hole-punched paper with the holes toward the right side of the printer.

• Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams.
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5. Slide the tray into the printer until the tray stops.

6. If the control panel Paper Settings screen prompts you, verify the paper size, type, and color.

7. Touch Confirm.

CCoonnffiigguurriinngg tthhee DDuupplleexx UUnniitt WWiiddtthh SSiizzee
Use the following procedure to change the duplex unit width size.

72 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Paper and Media



Note: Depending on your country, the duplex unit is preset to Letter/Legal width or A4 width.

1. At the back of the printer, pull out and remove the duplex unit.

2. Adjust the width guide:

a. To access the width guide, turn over the duplex unit.

Note: The width guide is located on the bottom of the duplex unit.
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b. Adjust the width guide to match the width of paper that you are using for your print job.

Note: You can use Letter/Legal or A4 width sizes.

c. Turn over the tray.

3. Insert the duplex unit into the printer, then push in the unit until it stops.
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Printing on Special Paper
To order paper, transparencies, or other media, contact your local reseller or go to:

• www.xerox.com/office/WC3335supplies

• www.xerox.com/office/WC3345supplies

EEnnvveellooppeess
Note: You can print envelopes only from the bypass tray. For details, see Supported Supported
Standard Paper Sizes.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg EEnnvveellooppeess
• Print quality depends on the quality and construction of the envelopes. Try another envelope

brand if you do not get desired results.

• Maintain constant temperatures and relative humidity.

• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

• Before loading envelopes into the tray, remove air bubbles by setting a heavy book on top of
them.

• In the print driver software, select Envelope as the paper type.

• Do not use padded envelopes. Use envelopes that lie flat on a surface.

• Do not use envelopes with heat-activated glue.

• Do not use envelopes with press-and-seal flaps.

• Use only paper envelopes.

• Do not use envelopes with windows or metal clasps.

LLooaaddiinngg EEnnvveellooppeess iinn tthhee BByyppaassss TTrraayy
1. Open the bypass tray.

Note: If the bypass tray is open and loaded with paper already, remove any paper that is a
different size or type.
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a. To open the bypass tray, press the cover.
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b. Extend the bypass tray fully.

2. Move out the length and width guides.
If you do not load envelopes in the bypass tray right after you remove the envelopes from the
packaging, they can bulge. To avoid jams, flatten the envelopes before loading them into the
printer.
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3. To load envelopes, place the envelopes with the print side up, flaps closed and down, and the flap
of the envelope to the left.

4. If the control panel Paper Settings screen prompts you, verify the paper size, type, and color.

5. When finished, touch Confirm.

LLaabbeellss
Note: You can print labels only from the Bypass Tray.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg LLaabbeellss
Caution: Do not use any sheet where labels are missing, curled, or pulled away from the
backing sheet. It could damage the printer.

• Use labels designed for laser printing.

• Do not use vinyl labels.

• Do not feed a sheet of labels through the printer more than once.
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• Do not use dry gum labels.

• Print only on one side of the sheet of labels. Use full sheet labels only.

• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions.
Storing them in extreme conditions can cause print-quality problems or cause them to jam in the
printer.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

• In the print driver software, select Label as the paper type.

• Before loading labels, remove all other paper from the bypass tray.

LLooaaddiinngg LLaabbeellss iinn tthhee BByyppaassss TTrraayy
To load labels in the bypass tray:

1. Open the bypass tray.

Note: If the bypass tray is open and loaded with paper already, remove any paper that is a
different size or type.
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a. To open the bypass tray, press the cover.
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b. Extend the bypass tray fully.
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2. Move out the length and width guides.

82 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Paper and Media



3. Load the labels face up.

4. Adjust the guides until they touch the edges of the paper.

5. If the control panel prompts you, in the Paper Settings screen, verify the paper size, type, and
color.

6. When finished, touch Confirm.

TTrraannssppaarreenncciieess
Note: You can print transparencies only from the bypass tray.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg TTrraannssppaarreenncciieess
• Remove all paper before loading transparencies in the bypass tray.

• Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print
quality.

• After loading transparencies, change the paper type to Transparency on the printer control panel.
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• In the print driver software, for paper type, select Transparency.

• Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.

• Do not fan transparencies.
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Printing Overview
Before printing, your computer and the printer must be plugged in, turned on, and connected to an
active network. Make sure that you have the correct print driver software installed on your computer.
For details, refer to Installing the Software.

1. Select the appropriate paper.

2. Load paper in the appropriate tray.

3. At the printer control panel, specify the size and type.

4. In your software application, access the print settings. For most software applications, press
CTRL→P for Windows or CMD→P for Macintosh.

5. Select your printer.

6. To access the print driver settings for Windows, select Properties or Preferences. For Macintosh
select Xerox® Features.

7. Select the desired options.

8. To send the job to the printer, click Print.

Related Topics:
Loading Paper
Selecting Printing Options
Printing on Both Sides of the Paper
Printing on Special Paper
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Selecting Printing Options
Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing,
page layout, and print quality. You can choose default settings for various printing options; for more
information refer to Setting Default Printing Options for Windows and Selecting Printing Options for
Macintosh. Printing options that you set from within the software application are temporary and are
not saved.

PPrriinntt DDrriivveerr HHeellpp
Xerox® print driver software Help is available from the Printing Preferences window. To see print driver
help, click the Help (?) button in the bottom left corner of the Printing Preferences window.

Information about Printing Preferences appears in the Help window on two tabs:

• Contents provides a list of the driver tabs at the top and the areas at the bottom of the Printing
Preferences window. To find explanations for each of the driver fields and areas, in the Printing
Preferences window, click the Contents tab.

• Search provides a field where you can enter the topic or function for which you need information.
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WWiinnddoowwss PPrriinnttiinngg OOppttiioonnss

SSeettttiinngg DDeeffaauulltt PPrriinnttiinngg OOppttiioonnss ffoorr WWiinnddoowwss
When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so
that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, in Printing Preferences,
specify 2-sided printing.

To select default printing options:

1. On your computer, navigate to the list of printers:

a. For Windows Vista, click Start→Control Panel→Hardware and Sound→Printers.

b. For Windows 7, click Start→Devices and Printers.

c. For Windows 8, click Control Panel→Devices and Printers.

Note: If the Control Panel icon does not appear on the desktop, right-click on the
desktop, then select Personalize→Control Panel Home→Devices and Printers.

2. In the list, right-click the icon for your printer and click Printing Preferences.

3. In the Printing Preferences window, click a tab, select the options, then click OK to save.

For more information about Windows print driver options, in the Printing Preferences window,
click the Help button (?).

SSeelleeccttiinngg WWiinnddoowwss PPrriinntt OOppttiioonnss ffoorr aann IInnddiivviidduuaall JJoobb
To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer. For example, if you want the highest print quality when you print a
document, in Printing Preferences, select Enhanced, then submit the print job.

1. With the document open in your software application, access the print settings. For most
software applications, click File→Print or press CTRL→P.

2. To open the Properties window, select your printer, then click the Properties or Preferences
button. The title of the button varies depending on your application.

3. In the Properties window, click a tab, then make selections.

4. To save your selections and close the Properties window, click OK.

5. To send the job to the printer, click OK.

SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr WWiinnddoowwss
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File→Print.

2. Select the printer, then click Properties.

3. In the Properties window, select the desired settings for each tab.
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4. To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the
window, then click Save As.

5. Type a name for the set of printing options, then to save the set of options in the Saved Settings
list, clickOK.

6. To print using these options, select the name from the list.

MMaacciinnttoosshh PPrriinnttiinngg OOppttiioonnss

SSeelleeccttiinngg PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
To use specific printing options, change the settings before sending the job to the printer.

1. With the document open in your application, click File→Print.

2. Select your printer.

3. Select Xerox® Features.

4. Select the desired options.

5. Click Print.

SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File→Print.

2. In the printer list, select your printer.

3. Select the desired printing options.

4. To save the settings, select Save Current Settings as Preset.

LLiinnuuxx PPrriinnttiinngg OOppttiioonnss

LLaauunncchhiinngg XXeerrooxx®® PPrriinntteerr MMaannaaggeerr
To launch Xerox®Printer Manager from a command line prompt:

1. Login in as root.

2. Type xeroxprtmgr.

3. Press Enter or Return.
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PPrriinnttiinngg ffrroomm aa LLiinnuuxx WWoorrkkssttaattiioonn
The Xerox® print driver accepts a job ticket setting file that contains preset printing features. You can
also submit print requests through the command line using lp/lpr. For more information about Linux
printing, click the Help (?) button in the Xerox® print driver.

1. Create a print queue. To set up a queue, refer to the System Administrator Guide:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs

2. With the desired document or graphic open in your application, open the Print dialog box.
For most software applications, click File→Print or press CTRL→P.

3. Select the target print queue.

4. Close the Print dialog box.

5. In the Xerox® print driver, select the available printer features.

6. Click Print.

Creating a Job Ticket Using the Xerox Print Driver
1. In a command line prompt, open the Xerox® print driver, login as root, and type xeroxprtmgr.

2. On the My Printers screen, select the printer.

3. In the top corner, click Edit Printer, then select options for the print job.

4. Click Save As, then store the job ticket in your home directory.

Personally identifiable information, such as a Secure Print passcode, is not saved in the job ticket.
You can specify the information on the command line.

To print using the job ticket, type the command lp -d{Target_Queue} - oJT=<path_to_
ticket> <file_name>.

The following commands are examples of how to print using a job ticket:

lp -d{Target_Queue} -oJT={Absolute_Path_To_Job_Ticket} {Path_To_Print_
File}

lp -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile

lp -dMyQueue -oJT=/tmp/Secure -oSecurePasscode=1234 /home/user/
PrintReadyFile

MMaannaaggiinngg JJoobbss

MMaannaaggiinngg JJoobbss aatt tthhee CCoonnttrrooll PPaanneell
From the control panel Job Status screen, you can view lists of active jobs or completed jobs. You can
pause, delete, print, or view job progress or job details for a selected job.

To Pause and Restart Printing
1. To pause printing, at the control panel, press the Interrupt Printing button.

2. To resume printing, press the Interrupt Printing button.
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To Pause a Print Job in Progress with the Option to Delete It
1. At the control panel press the Stop button.

2. Do one of the following:
• To delete the print job, touch Cancel.
• To resume the print job, touch Resume.

To View Active or Completed Jobs
1. At the control panel, press the Job Status button.

2. To see a list of specific job types, touch a tab.
• To view jobs that are in process or waiting to process, touch the Active tab.
• To view completed jobs, touch the Completed Jobs tab.
• To view details about a job, touch the job name.

To Delete an Active Job
1. At the control panel, press the Job Status button.

2. Touch the Active tab.

3. Touch the folder of the active job.

4. Touch Delete.

The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them. Only the user that sent the job
or the system administrator can delete an active print job.

MMaannaaggiinngg JJoobbss iinn XXeerrooxx®® CCeennttrreeWWaarree®® IInntteerrnneett SSeerrvviicceess
You can view a list of active jobs and delete print jobs from the Active Jobs list in Xerox® CentreWare®
Internet Services. You can also print, copy, move, or delete saved jobs. For details, refer to the Help in
Xerox® CentreWare® Internet Services

PPrriinnttiinngg FFeeaattuurreess

PPrriinnttiinngg oonn BBootthh SSiiddeess ooff tthhee PPaappeerr

Paper Types for Automatic 2-Sided Printing
The printer can print a 2-sided document automatically on supported paper. Before printing a 2-sided
document, verify that the paper type and weight are supported. For details, refer to Supported Paper
Types and Weights for Automatic 2-Sided Printing.

Printing a 2-Sided Document
Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the
settings for portrait or landscape orientation from the application for printing the document.

2-Sided Page Layout Options
You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page-orientation settings.
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Portrait Landscape

2-Sided Print 2-Sided Print, Flip on
Short Edge

2-Sided Print 2-Sided Print, Flip on
Short Edge

SSeelleeccttiinngg PPaappeerr OOppttiioonnss ffoorr PPrriinnttiinngg
There are two ways to select the paper for your print job:

• Let the printer automatically select which paper to use based on the document size, paper type,
and paper color you specify.

• Select a specific tray loaded with the desired paper.

PPrriinnttiinngg MMuullttiippllee PPaaggeess ttoo aa SSiinnggllee SShheeeett

When printing a multiple-page document, you can print more than one page
on a single sheet of paper.
1 From the Document Options tab, on the Page Layout tab, select Pages Per

Sheet.
2 Select 1, 2, 4, 6, 9, or 16 pages per side.

SSccaalliinngg
Scaling reduces or enlarges the original document to match the selected output paper size. In
Windows, the Scale Options are located in the print driver on the Printing Options tab in the Paper
field.

To access Scale Options, click the arrow at the right side of the Paper field, select Other Size, then
select Advanced Paper Size.

• No Scaling: This option does not change the size of the page image printed on the output paper,
and 100% appears in the percentage box. If the original size is larger than the output size, the
page image is cropped. If the original size is smaller than the output size, extra space appears
around the page image.

• Automatically Scale: This option scales the document to fit the selected Output Paper Size. The
scaling amount appears in the percentage box below the sample image.

• Manually Scale: This option scales the document by the amount entered in the percentage box
below the preview image.
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PPrriinntt QQuuaalliittyy
Print-quality modes:

• Standard print-quality mode: 600 x 600 dpi (dots per inch)

• Enhanced print-quality mode: 600 x 600 x 5 dpi (1200 x 1200 enhanced image quality)

Note: The print resolutions are indicated for PostScript print drivers only. The only print-quality
mode for PCL is Enhanced.

SSaavveedd JJoobbss
You can use the controls in the Saved jobs window to save the job, or you can print and save the job
for future use.

PPrriinntt FFrroomm
Print From allows printing of documents stored on the printer, on a computer on a network, or on a
USB Flash drive.

PPrriinnttiinngg ffrroomm SSaavveedd JJoobbss
1. At the control panel, press the Services button, then touch Saved Jobs.

2. Touch the name of the saved job that you want to print.

3. Touch OK.

4. Press the green Start button.

5. After the job prints, to return to the list of saved jobs, touch Browse.

PPrriinnttiinngg ffrroomm aa UUSSBB FFllaasshh DDrriivvee
You can print .pdf, .ps, .pcl, .prn, .tiff, and .xps files directly from a USB Flash drive.

Note: If USB ports are disabled, you cannot use a USB card reader for authentication, to
update the software, or to print from a USB Flash drive.

The system administrator must set up this feature before you can use it. For details, refer to the
System Administrator Guide at:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs

To print from a USB Flash drive:

1. Insert your USB Flash drive in a USB port on the printer. The Print from USB window appears.

The list at the bottom of the window displays the folders and printable files on the USB Flash
drive.

2. To scroll through the list and locate the printable file, next to the list, use the arrows.

3. If the print file is in a folder, to open the folder, touch the folder name.

4. Touch the name of the printable file.
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5. Select the number of copies, paper size, paper color, paper type, 2-sided printing, and finishing
options.

6. Press the green Start button.

7. To go back to the last screen, touch Back.

8. To look for other folders and printable files, touch Browse.
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Basic Copying
1. To clear previous settings, at the control panel, press the yellow Clear All button. The Clear All

Confirmation screen appears.

2. Touch Confirm or Close.

3. Load your original documents.
• Use the document glass for single pages or paper that cannot be fed using the document

feeder. Place the first page of the document face down, in the top left corner of the document
glass.

• Use the document feeder for multiple or single pages. Remove any staples and paper clips
from the pages and place them face up in the document feeder.

4. Press the Services Home button, then touch Copy.

5. To enter the number of copies, use the alphanumeric keypad on the touch screen or the control
panel. Touch the right arrow key.

6. Change the copy settings as needed. Refer to Selecting Copy Settings.

7. Press the green Start button.

• To pause or cancel a copy job, press the red Stop button.

• To interrupt a copy job, press the Interrupt Printing button.

DDooccuummeenntt GGllaassss

DDooccuummeenntt GGllaassss GGuuiiddeelliinneess
The document glass accommodates original sizes up to 210 x 297 mm (A4/8.5 x 11 in.). Use the
document glass rather than the document feeder to copy or scan the following types of originals
documents:

• Paper with paper clips or staples attached

• Paper with wrinkles, curls, folds, tears, or notches

• Coated or carbonless paper or items other than paper such as cloth or metal

• Envelopes

• Books
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UUssiinngg tthhee DDooccuummeenntt GGllaassss

1. Lift the document feeder cover.

2. Place the first page face down in the upper-left corner of the document glass.

3. Align the originals to the matching paper size printed on the edge of the glass.

• The document glass accommodates original sizes up to 210 x 297 mm (A4/8.5 x 11 in.).

• The document glass automatically detects letter (8.5 x 11 in.), A4, and smaller paper sizes.

DDooccuummeenntt FFeeeeddeerr

DDooccuummeenntt FFeeeeddeerr GGuuiiddeelliinneess
When loading original documents into the document feeder, follow these guidelines:

• Insert originals face up with the top of the page entering the feeder first.

• Only place loose sheets of paper in the document feeder.

• Adjust the paper guides so that they fit against the original documents.

• Insert paper in the document feeder only when ink on the paper is dry.

• Do not load original documents above the MAX fill line.
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UUssiinngg tthhee DDooccuummeenntt FFeeeeddeerr

• The document feeder accepts paper weights from 50–105 g/m² (12.5–28 lb.) for 2-sided pages.

• The document feeder accepts paper sizes from 145 x 145 mm—216 x 356 mm (5.7 x 5.7 in.—8.5
x 14 in.) for 1-sided pages, and 176 x 250 mm—216 x 356 mm (6.93 x 9.84 in.—8.5 x 14 in.) for
2-sided pages.

• The maximum feeder capacity is approximately 100 sheets of 75 g/m² paper.

1. Insert original documents face up, with page one on top.

2. Adjust the paper guides so that they fit against the original documents.
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Selecting Copy Settings

BBaassiicc SSeettttiinnggss

SSeelleeccttiinngg aa PPaappeerr TTrraayy
1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Touch the Paper Supply tab.

5. Touch one of the options.

6. Touch OK.

SSeelleeccttiinngg 22--SSiiddeedd CCooppyy OOppttiioonnss
1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Touch 2-Sided Copying.

5. Touch an option.

6. Touch OK.

SSppeecciiffyyiinngg tthhee SSiizzee ooff tthhee OOrriiggiinnaall
To scan the correct area of the original, specify the original size.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Original Size .

5. Touch an option.
• Preset Scan Area: You can specify the area to scan when it matches a standard paper size.

Note: Grayed-out options are not available.

• Custom Scan Area: You can specify the height and width of the area to scan.

6. Touch OK.
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IImmaaggee QQuuaalliittyy SSeettttiinnggss

SSppeecciiffyyiinngg tthhee OOrriiggiinnaall TTyyppee
The printer optimizes the image quality of the copies based on the type of images in the original
document and how the original was created.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Original Type.

5. Select an option.

6. Touch OK.

MMaakkiinngg tthhee IImmaaggee LLiigghhtteerr oorr DDaarrkkeerr
1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch the Lighten/Darken tab.

5. Adjust the slider as needed.

6. Touch OK.

AAuuttoommaattiiccaallllyy SSuupppprreessssiinngg BBaacckkggrroouunndd VVaarriiaattiioonn
When scanning originals printed on thin paper, text or images printed on one side of the paper can
be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Background Suppression.

5. For Background Suppression, touchAuto Suppression.

6. Touch OK.
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OOuuttppuutt AAddjjuussttmmeennttss

RReedduucciinngg oorr EEnnllaarrggiinngg tthhee IImmaaggee
You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%.

To reduce or enlarge the image:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Touch Reduce/Enlarge.

5. Touch an option.
• To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-).
• To reduce or enlarge the percentage incrementally, touch the arrows.
• To reduce or enlarge the percentage using the alphanumeric keypad, touch the current

displayed value, then enter a value.
• Touch OK.

6. Touch OK.

EErraassiinngg tthhee EEddggeess ooff CCooppiieess
You can erase content from the edges of your copies by specifying the amount to erase on the right,
left, top, and bottom edges.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Edge Erase.

5. Select an option.

6. Touch OK.

PPaaggee LLaayyoouutt
You can use Page Layout to place a defined number of pages on one or both sides of the paper.

Note: Page Layout is disabled unless a preset Original Size is selected.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Page Layout.

5. Touch an option.

6. For Paper Supply, touch the desired tray.

7. Touch OK.
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SShhiiffttiinngg tthhee IImmaaggee
You can change the placement of an image on the copy page. For Image Shift to function correctly,
position originals as follows.

1. Perform one of the following:
• For the Document Feeder, position originals face up, short edge entering the feeder first.
• For the Document Glass, position originals face down in the back-left corner of the document

glass with the short edge to the left.

2. At the printer control panel, press the Services Home button.

3. Touch Copy.

4. On the Copy tab, touch the Right arrow.

5. Scroll down to and touch Image Shift.

6. If the drop-down menu is set to Off, touch the drop-down arrow and select an option:
• Auto Center
• Margin Shift

7. Touch OK.

OOuuttppuutt FFoorrmmaatt SSeettttiinnggss

SSeelleeccttiinngg BBooookk CCooppyyiinngg
When copying a book, magazine, or other bound document, you can copy either the left or right page
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or
as a single image on one sheet of paper.

Note: Book Copying is disabled unless a preset Original Size is selected.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Book Copying .

5. Touch an option, then touch OK.

CCrreeaattiinngg aa BBooookklleett
You can print copies in booklet format. The booklet feature reduces the original page images to fit
two images on each side of the printed page.

Note: In this mode, the printer scans all of the originals before it prints the copies.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Booklet Creation.

5. Touch On.
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6. Select the desired options.

7. Touch OK.

IInncclluuddiinngg CCoovveerrss
You can print the first and last pages of your copy job on different paper, such as colored or
heavyweight paper. The printer selects the paper from a different tray. The covers can be blank or
printed.

1. Load the pages of the original document to be copied into the document feeder.

2. If necessary, load the paper to be used as the body pages of the copy into the desired tray.

3. Load the paper stock to be used for covers in a different tray.

4. At the printer control panel, press the Services Home button.

5. Touch Copy.

6. On the Copy tab, touch the Right arrow.

7. Under Paper Supply, touch the tray that contains the paper for the body pages of the job.

8. Touch OK.

9. Scroll down to and touch Covers.

10. Touch an option.

11. From the Cover menu, choose the desired option:
• Blank
• Print on Side 1 only
• Print on Both Sides

12. From the Tray Selection menu under the Cover menu, touch the tray from which to print the
covers.

13. Touch OK.

14. On the Copy tab, touch the Left arrow.

15. Select the Quantity of copies.

16. Press the green Start button.

AAddddiinngg TTrraannssppaarreennccyy SSeeppaarraattoorrss
You can add blank sheets of paper between each printed transparency. Ensure that the size and
orientation of the separators is the same as the transparencies.

Note: If the paper supply is set to Auto Select, you cannot add transparency separators.

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy tab, touch the Right arrow.

4. Scroll down to and touch Transparency Separators.
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5. Select an option:
• Off: This option does not insert a page between the transparencies.
• Blank: This option inserts a blank page between the transparencies.
• Printed: This option inserts a printed sheet of paper between the transparencies.

6. For Paper Supply, touch the desired tray.

7. Touch OK.

IIDD CCaarrdd CCooppyyiinngg
You can copy both sides of an ID card or small document onto one side of paper. Each side is copied
using the same location on the document glass. The printer stores both sides and prints them side by
side on the paper.

1. Press the Services Home button, then scroll down and touch ID Card Copy.

2. Select the number of copies using the keypad.

3. Touch the Right arrow.

4. To change the options for paper supply, to lighten or darken an image or to switch on auto
suppression, in the ID Card Copy screen, touch each tab and make appropriate changes.

5. Lift the document cover.

6. Place the ID card, or a document smaller than half the selected paper supply size, in the upper
left corner of the document glass.

7. Press the green Start button.

The first side of the ID card is copied and stored, and you will be prompted to turn over the ID
card and press Start.

8. Repeat the previous steps to copy the second side of the ID card.

The second side of the ID card is copied, and the copy is generated.

9. Lift the document cover and remove the ID card or document.
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This chapter contains:

• Loading Documents for Scanning.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
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• Scanning to an Email Address .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
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• Sending a Scanned Image to a Destination ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
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Loading Documents for Scanning

UUssiinngg tthhee DDooccuummeenntt GGllaassss

1. Lift the document feeder cover.

2. Place the first page face down in the upper-left corner of the document glass.

3. Align the originals to the matching paper size printed on the edge of the glass.

• The document glass accommodates original sizes up to 210 x 297 mm (A4/8.5 x 11 in.).

• The document glass automatically detects letter (8.5 x 11 in.), A4, and smaller paper sizes.

DDooccuummeenntt GGllaassss GGuuiiddeelliinneess
The document glass accommodates original sizes up to 210 x 297 mm (A4/8.5 x 11 in.). Use the
document glass rather than the document feeder to copy or scan the following types of originals
documents:

• Paper with paper clips or staples attached

• Paper with wrinkles, curls, folds, tears, or notches

• Coated or carbonless paper or items other than paper such as cloth or metal
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• Envelopes

• Books

UUssiinngg tthhee DDooccuummeenntt FFeeeeddeerr

• The document feeder accepts paper weights from 50–105 g/m² (12.5–28 lb.) for 2-sided pages.

• The document feeder accepts paper sizes from 145 x 145 mm—216 x 356 mm (5.7 x 5.7 in.—8.5
x 14 in.) for 1-sided pages, and 176 x 250 mm—216 x 356 mm (6.93 x 9.84 in.—8.5 x 14 in.) for
2-sided pages.

• The maximum feeder capacity is approximately 100 sheets of 75 g/m² paper.

1. Insert original documents face up, with page one on top.

2. Adjust the paper guides so that they fit against the original documents.

DDooccuummeenntt FFeeeeddeerr GGuuiiddeelliinneess
When loading original documents into the document feeder, follow these guidelines:

• Insert originals face up with the top of the page entering the feeder first.

• Only place loose sheets of paper in the document feeder.

• Adjust the paper guides so that they fit against the original documents.

• Insert paper in the document feeder only when ink on the paper is dry.

• Do not load original documents above the MAX fill line.

Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

107

Scanning



Scanning to a USB Flash Drive
You can scan a document and store the scanned file on a USB Flash drive. Scaning to a USB supports
scans in .jpg, .pdf, and .tiff file formats.

1. Load the original on the document glass or in the document feeder.

2. Insert your USB Flash drive into the USB port on the side of the printer.

The control panel touch screen displays the USB Device Detected screen.

3. If the USB Device Detected screen does not display automatically, on the control panel, touch
Scan to USB.

4. Change scan settings as needed. For details, refer to Adjusting Scanning Settings.

5. To begin the scan, press Start.

Note: Do not remove the USB Flash drive until prompted. If you remove the Flash drive
before the transfer is complete, the file can become unusable and other files on the drive
can be damaged.
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Scanning to a Shared Folder on a Network
Computer
Before you can scan to a shared folder, you must share the folder, then add the folder as an Address
Book entry in Xerox® CentreWare® Internet Services.

SShhaarriinngg aa FFoollddeerr oonn aa WWiinnddoowwss CCoommppuutteerr
Before you begin:

• Verify that your computer security software allows for file sharing.

• Verify that File and Printer Sharing For Microsoft Networks is enabled for each of your
connections.

Note: For assistance, contact your system administrator.

To turn on sharing:

1. Open Windows Explorer.

2. Right-click the folder you want to share, then select Properties.

3. Click the Sharing tab, then click Advanced Sharing.

4. Select Share this folder.

5. Click Permissions.

6. Select the Everyone group, and verify that all permissions are enabled.

7. Click OK.

8. Click OK again.

9. Click Close.
Remember the Share name for later use.

SShhaarriinngg aa FFoollddeerr UUssiinngg MMaacciinnttoosshh OOSS XX VVeerrssiioonn 1100..77
aanndd LLaatteerr
1. From the Apple menu, select System Preferences.

2. From the View menu, select Sharing.

3. From the Service list, select File Sharing.

4. Under Shared Folders, click the plus icon (+).

A folder list appears.

5. Select the folder that you want to share on the network, then click Add.

6. To modify access rights for your folder, select it. The groups activate.

7. From the Users list, click Everyone, then use the arrows to select Read & Write.

8. Click Options.

9. To share the folder with Windows computers, select Share files and folders using SMB.
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10. To share the folder with specific users, next to the user name, select On.

11. Click Done.

12. Close the System Preferences window.

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the
folder and subfolders.

AAddddiinngg aa FFoollddeerr aass aann AAddddrreessss BBooookk EEnnttrryy UUssiinngg
CCeennttrreeWWaarree IInntteerrnneett SSeerrvviicceess
1. At your computer, open a Web browser, in the address field, type the IP address of the printer,

then press Enter or Return.

2. Click Address Book.

3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book.

4. Click Add next to any empty field, and enter the following information:
• Name: Enter the name that you want to appear in the Address Book.
• Server Type: Select Computer (SMB).
• Host Address: Enter the IP address of your computer.
• Port Number: Enter the default port number for SMB, 139, or select a number from the range

provided.
• Login Name: Enter your computer user name.
• Login Password: Enter your computer login password.
• Reenter Password: Enter your login password again.
• Name of Shared Directory: Enter a name for the directory or folder. For example, if you want

the scanned files to go in a folder named scans type scans.
• Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want

the scanned files to go in a folder named colorscans inside the scans folder, type /colorscans.

5. Click Save Changes.

SSccaannnniinngg ttoo aa FFoollddeerr oonn aa NNeettwwoorrkk CCoommppuutteerr
1. Load the original document on the document glass or in the automatic document feeder.

2. On the printer control panel, touch Scan to.

3. Touch the Right Arrow button until the Scan To Network screen appears.

4. Touch OK.

5. At Scan to, touch OK.

6. At Computer (Network), touch OK.

7. Use the arrow buttons to select the shared folder on your computer, then touch OK.

8. If you want to change any other scan settings, use the arrow buttons to select the setting, and
make your changes. For details, refer to Adjusting Scanning Settings.

9. To begin the scan, press Start.
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Scanning to an Email Address
Note: When using this feature, the images you scan are sent as email attachments.

Before scanning to email, configure the email SMTP and From Field properties. You must have at least
one email address in the address book. If email properties are not properly configured, the Email icon
appears grayed out on the touch screen.

1. Load the original document on the document glass or in the document feeder.

2. On the printer control panel, touch Scan to.

3. Touch the Right Arrow button until the Scan To Email screen appears.

4. Choose the option for selecting the recipient:
• Keypad: This option allows you to enter the email address manually. Use the keypad to enter

the address.
• Address Book: This option allows you to select an email address from the Address Book.

Note: When using the Address Book, use the arrow buttons to select the address for the
desired recipient.

5. Press the green Start button.
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Scanning to a Computer
If the system administrator enables Remote Start in Xerox® CentreWare® Internet Services, you can
scan images directly from the scanner to a PC. Using Microsoft Clip Organizer, you can scan, import,
and store images from the printer. You can also scan directly from the printer to a computer using
most TWAIN-compliant scanning applications.

1. At the printer, load the original document on the document glass or in the document feeder.

2. At your computer, click Start→Programs→Microsoft Office→Microsoft Office Tools→Microsoft
Clip Organizer.

3. Click File→Add Clips to Organizer→From Scanner or Camera.

4. Click Device→Xerox TWAIN Driver.

5. Click Custom Insert.

6. If multiple scanners are installed on your computer, click Select Scan Device, select the scanner,
then click Select.

7. To select a size for the scanned image, clickScan Size, then select an option.

8. To select the sides to scan from the original document, click Side to Scan, then select an option:
• 1-Sided Scan: This option scans only one side of the original document or image and

produces 1-sided output files.
• 2-Sided Scan: This option scans both sides of the original document or image.
• 2-Sided Scan, Short Edge: This option scans both sides of the original image on the short

edge.
• To select the resolution to scan the image, click Resolution, then select an option.

9. To adjust the scan color, click Image Color and select an option:
• Auto: This option detects the color content in the original image. If the original image is

color, the printer scans in full color. If the original is a black and white document, the printer
scans in black and white only.

• Color: This option scans in full color.
• Grayscale: This option detects color content and scans as various shades of gray.
• Black and White: This option scans in black and white only.
• To scan the image, click Scan.

10. To select the resolution to scan the image, click Resolution, then select an option.

11. To scan the image, click Scan.
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Sending a Scanned Image to a Destination
Before scanning to a destination, configure the destination folders on the server or share the folder on
a personal computer. In addition, you must have at least one Scan To Destination in the address
book. If Scan To Destination properties are not properly configured, the Scan To icon appears grayed
out on the touch screen.

To scan an image and send it to a destination:

1. Load the original document on the document glass or in the document feeder.

2. Touch Scan To→Scan Contacts.

3. Select an option.

4. Select the desired name from the list, then touch OK.

5. Change scan settings as needed.

6. Press the green Start button.

For details, refer to Adjusting Scanning Settings.
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Adjusting Scanning Settings

SSeettttiinngg tthhee OOuuttppuutt CCoolloorr
If the original image contains color, you can scan the image in color or in black and white. Selecting
black and white significantly reduces the file size of the scanned images.

To set the output color:

1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To.

3. Touch the Right Arrow button until the Scan To...Features screen appears.

4. Touch Output Color.

5. Select a color mode.

6. Touch OK.

SSeettttiinngg tthhee SSccaann RReessoolluuttiioonn
The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both
the size and image quality of the scanned image file. Higher scan resolution produces better image
quality and a larger file size.

1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To.

3. Touch the Right Arrow button until the Scan To...Features screen appears.

4. Scroll down and touch Resolution.

5. Select an option.

6. Touch OK.

SSeelleeccttiinngg 22--SSiiddeedd SSccaannnniinngg
2-Sided Scanning scans both sides of the original document.

Note: 2-Sided Scanning is only available on devices that have a duplex document feeder.

1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To, then touch and hold the Right Arrow button until Scan To...Features appears.

3. Touch 2-Sided Scanning.

4. Select an option.

5. Touch OK.
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SSeettttiinngg tthhee FFiillee FFoorrmmaatt
1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To, then touch and hold the Right Arrow button until Scan To...Features appears.

3. Touch File.

4. Using the menu, select a file type, then type the file name using the keypad.

5. Touch OK.

LLiigghhtteenniinngg oorr DDaarrkkeenniinngg tthhee IImmaaggee
1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To, then touch and hold the Right Arrow button until Scan To...Features appears.

3. Scroll down, then touch Lighten/Darken.

4. Using the slider control, make the desired adjustment.

5. Touch OK.

AAuuttoommaattiiccaallllyy SSuupppprreessssiinngg BBaacckkggrroouunndd VVaarriiaattiioonn
When scanning original documents that are printed on thin paper, text or images printed on one side
of the paper can be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity
of the printer to variations in light background colors.

1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To, then touch and hold the Right Arrow button until Scan To...Features appears.

3. Touch Background Suppression.

4. Choose Enable or Disable.

5. Touch OK.

SSppeecciiffyyiinngg tthhee OOrriiggiinnaall SSiizzee
1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To, then touch and hold the Right Arrow button until Scan To...Features appears.

3. Touch Original Size.

4. Select an option.

5. Touch OK.

EErraassiinngg EEddggeess
1. At the printer control panel, press Clear All, then press Services Home.

2. Touch Scan To, then touch and hold the Right Arrow button until Scan To...Features appears.

3. Touch Scan To Edge.
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4. Select an option.

5. Touch OK.
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Basic Faxing
To send a fax:

1. Load your original documents:
• Use the document glass for single pages or paper that cannot be fed using the document

feeder. Place the first page of the document face down, in the top-left corner of the document
glass.

• Use the document feeder for multiple or single pages. Remove any staples and paper clips
from the pages and place them face up in the document feeder.

2. Press the Services Home button, then touch Fax.

3. Address the fax using one or more of the available options:
• Enter Recipient: This option allows you to enter a fax number manually.
• Manual Dial Mode: This option allows you to insert characters, such as Dial Pause, in a fax

number.
• Device Address Book: This option allows you to access the printer address book.

4. Adjust additional fax options as needed.
For details, refer to Selecting Fax Options.

5. Press the green Start button.

The printer scans the pages and transmits the document when all pages have been scanned.
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UUssiinngg tthhee DDooccuummeenntt GGllaassss

1. Lift the document feeder cover.

2. Place the first page face down in the upper-left corner of the document glass.

3. Align the originals to the matching paper size printed on the edge of the glass.

• The document glass accommodates original sizes up to 210 x 297 mm (A4/8.5 x 11 in.).

• The document glass automatically detects letter (8.5 x 11 in.), A4, and smaller paper sizes.

DDooccuummeenntt GGllaassss GGuuiiddeelliinneess
The document glass accommodates original sizes up to 210 x 297 mm (A4/8.5 x 11 in.). Use the
document glass rather than the document feeder to copy or scan the following types of originals
documents:

• Paper with paper clips or staples attached

• Paper with wrinkles, curls, folds, tears, or notches

• Coated or carbonless paper or items other than paper such as cloth or metal

• Envelopes

• Books
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UUssiinngg tthhee DDooccuummeenntt FFeeeeddeerr

• The document feeder accepts paper weights from 50–105 g/m² (12.5–28 lb.) for 2-sided pages.

• The document feeder accepts paper sizes from 145 x 145 mm—216 x 356 mm (5.7 x 5.7 in.—8.5
x 14 in.) for 1-sided pages, and 176 x 250 mm—216 x 356 mm (6.93 x 9.84 in.—8.5 x 14 in.) for
2-sided pages.

• The maximum feeder capacity is approximately 100 sheets of 75 g/m² paper.

1. Insert original documents face up, with page one on top.

2. Adjust the paper guides so that they fit against the original documents.

DDooccuummeenntt FFeeeeddeerr GGuuiiddeelliinneess
When loading original documents into the document feeder, follow these guidelines:

• Insert originals face up with the top of the page entering the feeder first.

• Only place loose sheets of paper in the document feeder.

• Adjust the paper guides so that they fit against the original documents.

• Insert paper in the document feeder only when ink on the paper is dry.

• Do not load original documents above the MAX fill line.
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Selecting Fax Options

SSppeecciiffyyiinngg tthhee SSiizzee ooff tthhee OOrriiggiinnaall
To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:

1. At the printer control panel, press Services Home.

2. Touch Fax, then touch an option.

3. At the top of the screen, touch the right arrow two times, then touch Original Size.

4. Touch an option, then touch OK.

SSeennddiinngg aa DDeellaayyeedd FFaaxx
You can scan and save a fax on the printer, then send it at a later time.

Note: A delay time of 15 minutes or more must be set; otherwise, the job is sent immediately.

1. At the printer control panel, press Services Home.

2. Touch Fax.

3. At the top of the screen, touch the right arrow two times, scroll down, and touch Delay Send.

4. Use the drop-down menu to set the feature to ON.

5. Touch the Hour field, then touch the arrows to set a number.

6. Touch the Minute field, then touch the arrows to set a number.

7. If your printer is set to display the 12-hour clock, touch AM or PM.

8. Touch OK.

AAuuttoommaattiiccaallllyy SSuupppprreessssiinngg BBaacckkggrroouunndd VVaarriiaattiioonn
When scanning originals printed on thin paper, text or images printed on one side of the paper can
be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1. At the printer control panel, press Services Home.

2. Touch Fax.

3. At the top of the Fax Features screen, touch the Right arrow two times.

4. Scroll down to and touch Background Suppression.

5. Choose either Off or Auto Suppression.

6. Touch OK.
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SSeennddiinngg HHeeaaddeerr TTeexxtt
The system administrator must set up this feature before you can use it. For details, refer to the
System Administrator Guide at:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs

To include the fax header text:

1. At the printer control panel, press Services Home.

2. Touch Fax.

3. At the top of the Fax Features screen, touch the Right arrow two times.

4. Scroll down to and touch Send Header Text.

5. Choose either Off or On.

6. Touch OK.

TToo LLiigghhtteenn oorr DDaarrkkeenn aann IImmaaggee
1. At the printer control panel, press Services Home.

2. Touch Fax.

3. At the top of the Fax Features screen, touch the Right arrow two times.

4. Touch Lighten/Darken.

5. Using the slider control, make the adjustment.

6. Touch OK.
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Storing a Fax in a Local Mailbox
The system administrator must create a mailbox and enable and configure Store to Mailbox before
you can use these features. For details, refer to the System Administrator Guide at:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs

To store a fax in a local mailbox:

1. At the printer control panel, press Services Home.

2. Touch Fax→Mailboxes.

3. Touch Store To Mailbox→Local Mailbox.

4. Enter a mailbox number and passcode, then touch OK.

Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

123

Faxing

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3335&PgName=man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3345&PgName=man&Language=English


Printing Local Mailbox Documents
To use this feature, you must have documents stored in a mailbox.

To print local mailbox documents:

1. At the printer control panel, press Services Home.

2. Touch Fax→Mailboxes.

3. Touch Print From Mailbox.

4. Touch Local Mailbox.

5. Enter a mailbox number and pass code, and touch Print.
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Sending a Fax to a Remote Mailbox
1. At the printer control panel, press Services Home.

2. Touch Fax→Mailboxes.

3. Touch Store To Mailbox→Remote Mailbox.

4. Enter a remote fax number.

5. Enter a remote mailbox number and passcode, then touch OK.
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Storing a Fax for Local or Remote Polling
Turn on Secure or Non-Secure Local Polling to make fax documents stored on one printer available for
remote polling by other printers. When Secure Local Polling is on, you create a list of fax numbers that
are allowed to access the stored faxes on the printer.

To store a fax:

1. At the printer control panel, press Services Home.

2. Touch Fax→Polling.

3. Touch Store Locally for Remote Polling.

4. Touch an option.

5. Touch OK.
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Polling a Remote Fax
You can retrieve documents that were stored using local polling on another fax machine.

To poll a remote fax:

1. At the printer control panel, press Services Home.

2. Touch Fax→Polling.

3. Touch Retrieve/Print Remote Files.

4. Type the fax number.

5. Touch OK.

Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

127

Faxing



Printing or Deleting Stored Faxes
1. At the printer control panel, press Services Home.

2. Touch Fax→Polling.

3. Touch Local File Management, then select Print All Files or Delete All Files.
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Using the Address Book

AAddddiinngg aann IInnddiivviidduuaall EEnnttrryy ttoo tthhee DDeevviiccee AAddddrreessss
BBooookk
The Device Address Book stores a maximum of 2000 contacts. If the Add button is unavailable, the
address book has reached its file limit.

Note: Before you can use this feature, the system administrator must enable Create/Edit
Contact from Touch Screen for All Users.

To add a recipient to the Device Address Book:

1. At the printer control panel, press Services Home.

2. Touch Fax→Enter Recipient.

3. To enter a name, fax number, or optional email address, touch each field, then enter the details.

4. Touch OK.

EEddiittiinngg aann IInnddiivviidduuaall AAddddrreessss BBooookk EEnnttrryy
1. At the printer control panel, press Services Home.

2. Touch Fax→Device Address Book.

3. Touch the Address Book Entry.

4. Touch the Contact Name.

5. To edit the fields, touch Details.

6. To delete the contact, touch Remove.
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Cleaning the Printer

GGeenneerraall PPrreeccaauuttiioonnss
Caution: When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as
directed in this documentation.

WARNING: Keep all cleaning materials out of the reach of children.

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized
sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

Caution: Do not remove the covers or guards that are fastened with screws. You cannot
maintain or service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your printer.

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are
open.

• Do not place anything on top of the printer.

• Do not open covers and doors during printing.

• Do not tilt the printer while it is in use.

• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the
print quality to deteriorate.

• Ensure that any parts removed during cleaning are replaced before you plug in the printer.

CClleeaanniinngg tthhee EExxtteerriioorr
Clean the exterior of the printer once a month.

Caution: Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild
detergent.

1. Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.

2. After cleaning, wipe with a dry, soft cloth.

Note: For stubborn stains, apply a small amount of mild detergent to the cloth and gently
wipe the stain off.

CClleeaanniinngg tthhee SSccaannnneerr
Clean the scanner about once a month, when anything is spilled on it, or when debris or dust collect
on any of the surfaces. Keep the feed rollers clean to ensure the best possible copies and scans.
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CClleeaanniinngg tthhee DDooccuummeenntt GGllaassss
1. Slightly dampen a soft, lint-free cloth with water.

2. Remove any paper from the document feeder.

3. Open the document cover.
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4. Wipe the surface of the document glass until it is clean and dry.
For best results, to remove marks and streaks, use a standard glass cleaner.
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5. Wipe the Constant Velocity Transport (CVT) glass until it is free of debris, and it is clean and dry.

Note: The CVT glass is the long narrow strip to the left of the document glass.
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6. Wipe the white underside of the document cover until it is clean and dry.
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7. Close the document cover.
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Ordering Supplies

WWhheenn ttoo OOrrddeerr SSuupppplliieess
A warning appears on the control panel when the Toner Cartridge or the Smart Kit Drum Cartridge
are near their replacement time. Verify that you have replacements on hand. It is important to order
these items when the messages first appear to avoid interruptions to your printing. An error message
appears on the control panel when the Toner Cartridge or the Smart Kit Drum Cartridge must be
replaced.

Order supplies from your local reseller or go to:

• www.xerox.com/office/WC3335supplies

• www.xerox.com/office/WC3345supplies

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies
not specified for this printer. The Total Satisfaction Guarantee is available in the United States
and Canada. Coverage could vary outside these areas. Please contact your Xerox representative
for details.

VViieewwiinngg PPrriinntteerr SSuuppppllyy SSttaattuuss
You can check the status and percentage of life remaining for your printer supplies at any time using
CentreWare Internet Services or the control panel.

Note: To view printer supply status using Xerox® CentreWare® Internet Services, refer the
System Administrator's Guide at:

• www.xerox.com/office/WC3335docs

• www.xerox.com/office/WC3345docs

To view printer supply status using the control panel:

1. At the printer, press the Services Home button.

2. Press the Machine Status button.

3. Touch the Supplies tab. A listing of all supplies status appears.

CCoonnssuummaabblleess
Consumables are printer supplies that get depleted during the operation of the printer. The
consumable supplies for this printer is the genuine Xerox® Black Toner Cartridge and the Xerox®
Smart Kit Drum Cartridge.

Note:

• Each consumable includes installation instructions.

• To ensure print quality, the toner cartridge and drum cartridge are designed to cease
functioning at a predetermined point.

138 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Maintenance

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WC3335&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WC3345&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3335&PgName=man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3345&PgName=man&Language=English


Caution: Use of non-Xerox supplies is not recommended. Use of toner with other than genuine
Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner
designed and manufactured under strict quality controls by Xerox for use with this specific
printer.

RRoouuttiinnee MMaaiinntteennaannccee IItteemmss
Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

• Standard Capacity Toner Cartridge

• High Capacity Toner Cartridge

• Extra High-Capacity Toner Cartridge

• Drum Cartridge

Note: Not all options listed are supported on all printers. Some options apply only to specific
printer models or configurations.

TToonneerr CCaarrttrriiddggeess

GGeenneerraall PPrreeccaauuttiioonnss ffoorr tthhee TToonneerr CCaarrttrriiddggee
WARNING:

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner,
have the child spit out the toner, and rinse the mouth with water. Consult a physician
immediately.

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills.
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large
volume of toner, contact your local Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can
catch fire and cause burn injuries or an explosion.

RReeppllaacciinngg aa TToonneerr CCaarrttrriiddggee
When a toner cartridge approaches the end of its usable life span, the control panel displays a toner-
low message. When a toner cartridge is empty, the printer stops and displays a message on the
control panel.

Note: Each toner cartridge includes installation instructions.
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Printer Status Message Cause and Solution

Low Toner Status: Ensure that a new Toner Cartridge
is available.

The toner cartridge is low. Order a new toner
cartridge.

Replace Toner Cartridge The toner cartridge is empty. Open the front cover,
then replace the toner cartridge.

DDrruumm CCaarrttrriiddggeess

GGeenneerraall PPrreeccaauuttiioonnss ffoorr tthhee DDrruumm CCaarrttrriiddggee
Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the drum.

Caution: Do not leave the covers and doors open for any length of time, especially in well-lit
places. Light exposure can damage the drum cartridge.

WARNING: Never throw a drum cartridge into an open flame. The cartridge can catch fire and
cause burn injuries or an explosion.

RReeppllaacciinngg aa DDrruumm CCaarrttrriiddggee
When a drum cartridge approaches the end of its usable life span, the control panel displays a drum-
cartridge low message. When a drum cartridge is empty, the printer stops and displays a message on
the control panel.

Note: Each drum cartridge includes installation instructions.

Printer Status Message Cause and Solution

Image Unit Low Status. Ensure that a new Drum
Cartridge is available.

The drum cartridge is low. Order a new drum
cartridge.

No message but the printer stops printing. The drum cartridge must be replaced. Open the front
cover, then replace the drum cartridge.

RReeccyycclliinngg SSuupppplliieess
For more information on the Xerox® supplies recycling program, go to:

• WorkCentre® 3335: www.xerox.com/gwa

• WorkCentre® 3345: www.xerox.com/gwa
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Moving the Printer
WARNING:

• To prevent electric shock, never touch the power plug with wet hands.

• When removing the power cord, ensure that you pull the plug and not the cord. Pulling the
cord can damage it, which can lead to fire or electric shock.

Caution: When moving the printer, do not tilt it more than 10 degrees to the front, back, left,
or right. Tilting the printer more than 10 degrees can cause toner spillage.

WARNING: If the optional 550-sheet feeder is installed, uninstall it before you move the
printer. If the optional 550-sheet feeder is not fixed to the printer securely, it can fall to the
ground and cause injury

Follow these instructions when moving the printer:

1. Turn off the printer and disconnect the power cord and other cables from the back of the printer.
For details, refer to Powering On or Off the Printer.

2. Remove any paper or other media from the output tray.

3. When moving the printer from one location to another, use caution to ensure that the printer
does not topple.
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4. Lift and carry the printer as shown in the illustration.

• Repack the printer and its options using the original packing material and boxes or a Xerox
Repackaging Kit. For a repacking kit and instructions, go to:

– www.xerox.com/office/WC3335support

– www.xerox.com/office/WC3345support

• When moving the printer over a long distance, remove the toner cartridges and drum
cartridges to prevent toner from spilling.

Caution: Failure to repackage the printer properly for shipment can result in damage not
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The
Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage
to the printer caused by improper moving.

5. After moving the printer:

a. Reinstall any parts you removed.

b. Reconnect the printer to the cables and power cord.

c. Plug in and switch on the printer.
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Billing and Usage Information
Billing and printer usage information appears on the Billing Meters information screen. The
impression counts shown are used for billing.

To view Billing and Usage information:

1. At the printer control panel, press the Machine Status button.

2. To view basic impression counts, touch the Billing Information tab.
A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed on
two sides counts as two impressions.

The machine serial number, number of black impressions, number of total impressions, and the
Usage Counters tab appear.

3. To view and update all usage counters, touch the Usage Counters tab.

4. Use the drop-down menu to select and view any of the following:
• Impressions
• Sheets
• Images Sent
• Fax Impressions
• All Usage

5. If necessary, touch the Update Counters tab to bring all counter data up to current usage.

Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

143

Maintenance



144 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Maintenance



Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

145

10
Troubleshooting
This chapter contains:

• General Troubleshooting ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

• Paper Jams ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150

• Print-Quality Problems... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188

• Copy and Scan Problems ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

• Fax Problems... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

• Getting Help ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197



General Troubleshooting
This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

RReessttaarrttiinngg tthhee PPrriinntteerr
To restart the printer:

1. Press Power Saver.

2. Touch Power Down.

3. To restart the printer, switch on the power switch.

Note: If restarting the printer does not resolve the problem, refer to Printer Fails to Power
On and Printer Resets or Turns Off Frequently.

PPrriinntteerr FFaaiillss ttoo PPoowweerr OOnn
Probable Causes Solutions

The power switch is not turned on. Turn on the power switch. For details, refer to Powering On or
Off the Printer.

The power cord is not correctly plugged into
the outlet.

Turn off the printer power switch, and plug the power cord
securely into the outlet. For details, refer to Powering On or Off
the Printer.

Something is wrong with the outlet
connected to the printer.

• Plug another electrical appliance into the outlet and see if
it operates properly.

• Try a different outlet.

The printer is connected to an outlet with a
voltage or frequency that does not match
the printer specifications.

Use a power source within the specifications for the printer.
For details, refer to Powering On or Off the Printer.

Caution: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

PPrriinntteerr RReesseettss oorr TTuurrnnss OOffff FFrreeqquueennttllyy

Probable Causes Solutions

The power cord is not plugged into the outlet
correctly.

Turn off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet,
then switch on the printer.

A system error occurred. Turn off the printer, then turn it on again. From the
printer control panel, access the Information Pages
menu, then print the Error History report. If the error
persists, contact your Xerox representative.
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Probable Causes Solutions

The printer is connected to an uninterruptible power
supply.

Turn off the printer, then connect the power cord to a
suitable outlet.

The printer is connected to a power strip shared with
other high-power devices.

Plug the printer directly into the outlet or into a
power strip that is not shared with other high-power
devices.

DDooccuummeenntt PPrriinnttss ffrroomm WWrroonngg TTrraayy

Probable Causes Solutions

Application and print driver have conflicting tray
selections.

1 Check the tray selected in the print driver.
2 Go to the page setup or printer settings of the

application from which you are printing.
3 Set the paper source to match the tray selected in

the print driver or set the paper source to
Automatically Select.

AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg PPrroobblleemmss

Probable Causes Solutions

Unsupported or incorrect paper. • Ensure that you are using a supported paper size
and weight for 2-sided printing. Envelopes and
labels cannot be used for 2-sided printing.

• For details, refer to Supported Paper Types and
Weights for Automatic 2-Sided Printing and
Supported Standard Paper Sizes for Automatic 2-
Sided Printing.

Incorrect setting. In the print driver Properties, select 2-Sided Print on
the Paper/Output tab.

PPaappeerr TTrraayy FFaaiillss ttoo CClloossee

Probable Cause Solution

The paper tray does not close fully. Some debris or an object is blocking the tray.
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PPrriinnttiinngg TTaakkeess TToooo LLoonngg

Probable Causes Solutions

The printer is set to a slower printing mode. For
example, the printer could be set to print on
Heavyweight paper.

It takes more time to print on certain types of special
paper. Ensure that the paper type is set properly in
the driver and at the printer control panel. For details,
refer to Print Speed.

The printer is in Power Saver mode. It takes time for printing to start when the printer is
exiting Power Saver mode.

The way the printer was installed on the network
could be an issue.

Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow print
speeds. To test the speed of the printer, print some
information pages such as the Office Demo Page. If
the page prints at the rated speed of the printer, you
could have a network or printer installation issue. For
help, contact the system administrator.

The job is complex. Wait. No action is needed.

The print-quality mode in the driver is set to
Enhanced.

Change the print-quality mode in the print driver to
Standard.

PPrriinntteerr FFaaiillss ttoo PPrriinntt
Probable Causes Solutions

The printer has an error. • To clear the error, turn off the printer, then turn it
on again.

• If the error persists, contact your Xerox
representative.

The printer is out of paper. Load paper into the tray.

A toner cartridge is empty. Replace the empty toner cartridge.

The power cord is not correctly plugged into the
outlet.

Turn off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet,
then switch on the printer. For details, refer to
Powering On or Off the Printer. If the error persists,
contact your Xerox representative.

148 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Troubleshooting



Probable Causes Solutions

The printer is busy. • A previous print job could be the problem. On
your computer, to delete all print jobs in the print
queue, you can use the Printer Properties feature.

• Load the paper in the tray.
• At the printer control panel, press the Job Status

button. If the print job does not appear, check the
Ethernet connection between the printer and the
computer.

• At the printer control panel, press the Job Status
button. If the print job does not appear, check the
USB connection between the printer and the
computer. Turn off the printer, then turn it on
again.

The printer cable is disconnected. • At the printer control panel, press the Job Status
button. If the print job does not appear check the
Ethernet connection between the printer and the
computer.

• At the printer control panel, press the Job Status
button. If the print job does not appear, check the
USB connection between the printer and the
computer. Turn off the printer, then turn it on
again.

PPrriinntteerr MMaakkeess UUnnuussuuaall NNooiisseess
Probable Causes Solutions

There is an obstruction or debris inside the printer. Turn off the printer and then remove the obstruction
or debris. If you cannot remove it, contact your Xerox
representative.

CCoonnddeennssaattiioonn hhaass FFoorrmmeedd IInnssiiddee tthhee PPrriinntteerr
Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room
that is heated quickly.

Probable Causes Solutions

The printer has been sitting in a cold room. • Allow the printer to acclimate for several hours
before operation.

• Allow the printer to operate for several hours at
room temperature.

The relative humidity of the room is too high. • Reduce the humidity in the room.
• Move the printer to a location where the

temperature and relative humidity are within the
operating specifications.
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Paper Jams

MMiinniimmiizziinngg PPaappeerr JJaammss
The printer is designed to function with minimal paper jams using Xerox supported paper. Other
paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of
the paper path.

The following can cause paper jams:

• Selecting the incorrect paper type in the print driver.

• Using damaged paper.

• Using unsupported paper.

• Loading paper incorrectly.

• Overfilling the tray.

• Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

• Use only supported paper. For details, refer to Supported Paper.

• Follow proper paper handling and loading techniques.

• Always use clean, undamaged paper.

• Avoid paper that is curled, torn, moist, creased, or folded.

• To separate the sheets before loading into the tray, fan the paper.

• Observe the paper tray fill line; never overfill the tray.

• After inserting paper in any tray, adjust the paper guides in the trays. A paper guide that is not
properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.

• After loading the trays, select the correct paper type and size on the control panel.

• When printing, in the print driver, select the correct type and size for the print job.

• Store paper in a dry location.

• Use only Xerox paper and transparencies designed for the printer.

Avoid the following:

• Polyester-coated paper that is specially designed for inkjet printers.

• Paper that is folded, wrinkled, or excessively curled.

• Loading more than one type, size, or weight of paper in a tray at the same time.

• Overfilling the trays.

• Allowing the output tray to overfill.
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LLooccaattiinngg PPaappeerr JJaammss
WARNING: To avoid injury, never touch a labeled area on or near the heat roller in the fuser. If
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Power
off the printer immediately, then wait 30 minutes for the fuser to cool. After the printer cools,
try to remove the jammed paper. If the error persists, contact your Xerox representative.

Caution: Do not attempt to clear any paper jams using tools or instruments. Tools and
instruments can damage the printer permanently.
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The following illustration shows where paper jams can occur along the paper path:

1. Bypass Tray and Inside the Front of the
Printer

2. Document Feeder Top Cover

3. Document Feeder Input Tray

4. Document Feeder Inside Cover

5. Back of the Printer

6. Duplex Area

7. Tray 1

8. Optional Tray 2
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CClleeaarriinngg PPaappeerr JJaammss

CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee DDooccuummeenntt FFeeeeddeerr
1. Remove any documents from the document feeder.

2. Open the document feeder top cover.
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3. If the paper is jammed in the exit of the document feeder, gently pull it out in the direction
shown.
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4. If the jammed paper is not caught in the entry of the document feeder, gently pull it out in the
direction shown.

5. If the jammed paper cannot be seen, perform the following steps to remove it.
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a. Open the inner cover.
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b. Gently pull out the jammed paper in the direction shown.
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c. Close the inner cover.
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6. Close the document feeder top cover.

7. To remove paper from the document feeder inside cover, perform the following steps:
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a. Lift the document feeder.
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b. Gently pull out any jammed paper.
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c. Close the document feeder.

8. Remove any jammed paper from the document feeder output tray.
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a. Raise the document feeder input tray.
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b. Gently pull out the jammed paper in the direction shown.

164 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Troubleshooting



c. Lower the document feeder input tray.

d. Reload the documents in the document feeder input tray, and adjust the guides against the
edges of the paper.
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CClleeaarriinngg PPaappeerr JJaammss aatt tthhee BByyppaassss TTrraayy
1. Remove any paper from the bypass tray.

2. Where the tray connects to the printer, clear any paper that is jammed.

3. If the paper is torn, check inside the printer for pieces of paper, then gently remove them. If you
cannot remove the paper fragments easily, contact your Xerox representative.

4. When you reload the bypass tray, fan the paper and ensure that all four corners align neatly.

5. If the control panel prompts you, verify the paper size and type on the screen.

6. Touch Confirm.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm TTrraayy 11
To resolve the error that appears on the control panel, clear all paper from the paper path.

1. Pull out tray 1 until it stops.
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2. To remove any jammed paper, gently pull it straight out as shown.

If the paper does not move when you pull it, or if you do not see the paper in this area, refer to
Clearing Paper Jams from the Inside the Printer.
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3. Close the tray.

4. If the control panel prompts you, on the Paper Settings screen, verify the paper size, type, and
color.

5. Touch Confirm.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm TTrraayy 22
To resolve the error that appears on the control panel, clear all paper from the paper path.

1. Pull out tray 2 until it stops.
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2. To remove any jammed paper, gently pull it straight out as shown.

3. If the paper does not move when you pull it, or if you do not see the paper in this area, perform
the following:
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a. Pull tray 1 out.

172 Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

Troubleshooting



b. To remove any jammed paper, gently pull it straight up and out as shown.

If the paper does not move when you pull, or if you do not see the paper in this area, refer to
Clearing Paper Jams from the Inside the Printer.
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c. Push in tray 1.
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4. Push in tray 2.

5. If the control panel prompts you, in the Paper Settings screen, verify the paper size, type, and
color.

6. Touch Confirm.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee OOuuttppuutt TTrraayy
1. To clear any jammed paper from the output tray area, gently pull out the paper straight as

shown.

2. If the paper tears or does not move when pulled, refer to Clearing Paper Jams from the Back of
the Printer.

3. If necessary, to resume printing, follow any remaining instructions on the printer control panel.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee IInnssiiddee tthhee PPrriinntteerr
1. Press the release lever, then open the front cover of the printer.
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2. To remove any jammed paper from inside the printer, gently pull it straight out as shown.
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3. Close the front cover.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee BBaacckk ooff tthhee PPrriinntteerr
1. At the back of the printer, remove any jammed paper from the exit area.

If the paper does not move when you pull it, continue to the next step.
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2. Press the release lever, then open the back cover of the printer.

3. Gently remove any jammed paper from the back of the printer.
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4. Gently remove any jammed paper from the fuser area.

WARNING: The area around the fuser can be hot. To avoid injury, use caution.

If the paper does not move when you pull it, continue to the next step.

5. If paper is jammed in the fuser, perform the following steps:

a. Lower both green levers, then open the fuser.

b. Remove the jammed paper.
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c. To open the paper guide and release the latches, press down both tabs, then lower the paper
guide.

d. Remove any jammed paper from the paper guide area.

e. Close the paper guide.

f. Close the fuser.

6. Close the back cover.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee DDuupplleexx AArreeaa
1. To access paper jams in the duplex area, pull out the duplex unit from the printer.

2. Gently remove any jammed paper from the duplex area.
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3. Push the duplex unit back into the printer.

Note: Ensure that the duplex unit is fully pushed in.

TTrroouubblleesshhoooottiinngg PPaappeerr JJaammss

MMuullttiippllee SShheeeettss PPuulllleedd TTooggeetthheerr

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper past
the fill line.

The edges of the paper are not even. Remove the paper, align the edges, then reload it.

The paper is moist from humidity. Remove the paper from the tray, then replace it with
new dry paper.

Too much static electricity is present. Try a new ream of paper.

Do not fan transparencies before loading them in
tray.
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Probable Causes Solutions

Using unsupported paper. Use only Xerox-approved paper. For details, refer to
Supported Paper.

Humidity is too high for coated paper. Feed paper one sheet at a time.

PPaappeerr MMiissffeeeeddss

Probable Causes Solutions

The paper is not correctly positioned in the tray. • Remove the misfed paper and reposition it
properly in the tray.

• Adjust the paper guides in the tray to match the
size of the paper.

The paper tray is too full. Remove some of the paper. Do not load paper past
the fill line.

The paper guides are not correctly adjusted to the
paper size.

Adjust the paper guides in the tray to match the size
of the paper.

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it
still misfeeds, do not use that paper.

The paper is moist from humidity. Remove the moist paper and replace it with new, dry
paper.

Using paper of the wrong size, thickness, or type. Use only Xerox approved paper. For details, refer to
Supported Paper.

LLaabbeell aanndd EEnnvveellooppee MMiissffeeeeddss

Probable Causes Solutions

Labels are missing, curled, or are pulling away from
the backing sheet.

Do not use any sheet where labels are missing,
curled, or pulled away from the backing sheet.

The label sheet is facing the wrong way in the tray. • Load label sheets according to the instructions
from the manufacturer.

• Load labels print side up in the bypass tray.
• Do not load labels in the high-capacity feeder.
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Probable Causes Solutions

Envelopes are loaded incorrectly in the bypass tray. • Load envelopes in the bypass tray with the print
side up, flaps closed, and the short edge leading
into the printer.

• Ensure that the width guides rest loosely against
the edge of the envelopes without restricting their
movement.

Envelopes are wrinkling. The heat and pressure of the laser printing process
can cause wrinkling. Use supported envelopes. For
details refer to Guidelines for Printing Envelopes.

PPaappeerr JJaamm MMeessssaaggee SSttaayyss OOnn

Probable Causes Solutions

Some paper remains jammed in the printer. Recheck the paper path. Ensure that you have
removed all of the jammed paper.

One of the printer doors is open. Check the doors on the printer. Close any door that is
open.

Note: Check for any torn pieces of paper in the paper path, then remove the paper.

JJaammss DDuurriinngg AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg

Probable Causes Solutions

Using paper of the wrong size, thickness, or type. • Use only Xerox-approved paper. For details, refer
to Supported Paper Types and Weights for
Automatic 2-Sided Printing.

• For automatic 2-sided printing, do not use
transparencies, envelopes, labels, reused paper,
damaged paper, or paper heavier than 105 g/m².

Paper is loaded in the wrong tray. Load paper into the correct tray. For details, refer to
Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.
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Print-Quality Problems
Your printer is designed to produce consistently high-quality prints. If you observe print-quality
problems, use the information in this section to troubleshoot the problem. For more information, go
to:

• www.xerox.com/office/WC3335support

• www.xerox.com/office/WC3345support

Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or specialty media. The Xerox Total
Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside
of these areas. For details, contact your local Xerox representative.

Note: To ensure consistent print quality, the toner cartridges and imaging units for many
models of equipment are designed to cease functioning at a predetermined point.

CCoonnttrroolllliinngg PPrriinntt QQuuaalliittyy
Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer and set the paper type correctly. To maintain optimum
print quality, follow the guidelines in this section.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal
print quality is 10–30ºC (50–90ºF) and 20–80% relative humidity.

SSoollvviinngg PPrriinntt--QQuuaalliittyy PPrroobblleemmss
When the print quality is poor, select the closest symptom from the following table and see the
corresponding solution to correct the problem. You can also print a Demo Page to determine the
print-quality problem more precisely.

If the print quality does not improve after carrying out the appropriate action, contact your Xerox
representative.

Note: To maintain print quality, when toner becomes low, a warning message appears on the
control panel. When the toner cartridge is empty, the printer stops printing, and a warning
message appears that prompts you to replace the toner cartridge. The printer stops printing
until you install a new toner cartridge.
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Symptom Solutions

The output is too light. • To check the toner level, check the control panel,
use the print driver, or Xerox®CentreWare®
Internet® Services. If the toner cartridge is almost
empty, replace it.

• Verify that the toner cartridge is approved for use
in this printer, and replace it as needed. For best
results, use a genuine Xerox® toner cartridge.

• Ensure that the print quality mode is not set to
Toner Saver. Toner Saver is useful for draft-quality
output.

• Replace the paper with a recommended size and
type, then confirm that your printer and print
driver settings are correct.

• Verify that the paper is dry and that supported
paper is used. If not, change the paper.

• Change the Paper Type settings in the print driver.
• In the print driver, open the Printing Preferences

menu, select the Paper/Output tab, then change
the Paper Type setting.

• If printer is located in a high-altitude
environment, adjust the altitude setting of the
printer. For details, refer to the System
Administrator Guide at:

– www.xerox.com/office/WC3335docs

– www.xerox.com/office/WC3345docs

Toner smears or print comes off.

The output has stains on the back side.

• Change the Paper Type settings in the print driver.
For example, change Plain to Lightweight
Cardstock.

• In the print driver, open the Printing Preferences
menu, select the Paper/Output tab, then change
the Paper Type setting.

• Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

• Verify that the printer is plugged into an outlet
that is providing the correct voltage and power.
Review the electrical specification of the printer
with an electrician if necessary.

• For details, refer to Electrical Specifications.

Random spots on the output, or the image is blurry. • Ensure that the toner cartridge is installed
correctly.

Xerox® WorkCentre® 3335/3345 Multifunction Printer
User Guide

189

Troubleshooting

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3335&PgName=man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3345&PgName=man&Language=English


Symptom Solutions

• Verify that the toner cartridge is approved for use
in this printer, and replace it as needed. For best
results, use a genuine Xerox® toner cartridge.

• Use the Heavyweight or Cardstock paper type
setting, or use a paper type with a smoother
surface.

• Ensure that the humidity in the room is within
specifications. For details, refer to Relative
Humidity.

• For details, refer to Selecting a Location for the
Printer.

The output is blank. Turn off the printer, then turn it on again.

If the error persists, contact your Xerox
representative.

Streaks appear in the output. Replace the Smart Kit Drum Cartridge.

Contact your Xerox representative.

The output has a mottled appearance. • Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

• Ensure that the humidity is within specifications.
For details, refer to Selecting a Location for the
Printer.

Ghosting appears in the printed output. • Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

• Change the Paper Type settings in the print driver.
• In the print driver, open the Printing Preferences

menu, select the Paper/Output tab, then change
the Paper Type setting.
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Symptom Solutions

• Replace the Drum Cartridge.

Auger marks appear on the printed output. • To check the toner level, check the control panel,
use the print driver, or Xerox®CentreWare®
Internet® Services. If the toner cartridge is almost
empty, replace it.

• Verify that the toner cartridge is approved for use
in this printer, and replace it as needed. For best
results, use a genuine Xerox® toner cartridge.

• Replace the Drum Cartridge.

The output print is wrinkled or stained. • Verify that the paper is the correct size, type, and
weight for the printer and that it is loaded
properly. If not, change the paper.

• Try a new ream of paper.
• Change the Paper Type settings in the print driver.
• In the print driver, open the Printing Preferences

menu, select the Paper/Output tab, then change
the Paper Type setting.

Envelopes are wrinkled or creased when printed. • Verify that envelopes are loaded properly in the
bypass tray.

• Follow the guidelines for printing on envelopes.
For details, refer to Guidelines for Printing
Envelopes.
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Symptom Solutions

The top margin is incorrect. • Verify that the paper is loaded properly.
• Verify that the margins are set correctly in the

application that you are using.

The printed surface of the paper is bumpy. 1 Print a solid image over the entire surface of one
sheet of paper.

2 Load the printed sheet into the tray with the
printed side face down.

3 Print five blank pages to remove debris from the
fuser rollers.
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Copy and Scan Problems
If the copy or scan quality is poor, refer to the following table.

Symptoms Solutions

Lines or streaks are present in copies only made from
the document feeder.

There is debris on the document glass. When
scanning, the paper from the document feeder
passes over the debris creating lines or streaks. Clean
all glass surfaces with a lint-free cloth.

Spots are present in copies taken from the document
glass.

There is debris on the document glass. When
scanning, the debris creates a spot on the image.
Clean all glass surfaces with a lint-free cloth.

The reverse side of the original appears on the copy
or scan.

Turn on Background Suppression.

The image is too light or too dark. To lighten or darken the image, use the Lighten/
Darken tab in either the Scan To or Copy function.

If the problem persists, for online support information, go to:

• www.xerox.com/office/WC3335support

• www.xerox.com/office/WC3345support
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Fax Problems
Note: If you cannot send and receive faxes, ensure that you are connected to an approved
analog or digital telephone line.

If you cannot send or receive faxes correctly, refer to the following tables.

PPrroobblleemmss SSeennddiinngg FFaaxxeess

Symptoms Causes Solutions

The document is not scanned
using the document feeder.

The document is too thick, too
thin, or too small.

Use the document glass to send
the fax.

The document is scanned at an
angle.

The document feeder guides are
not adjusted to the width of the
document.

Adjust the document feeder
guides to fit the width of the
document.

The fax that the recipient received
is blurry.

The document is incorrectly
positioned.

Position the document correctly.

The document glass is dirty. Clean the document glass.

The text in the document is too
light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the
telephone connection.

Verify that the telephone line is
working, then resend the fax.

There is a problem with the fax
machine of the caller.

Make a copy to verify that your
printer is operating correctly. If the
copy was printed correctly, have
the recipient verify the condition
of the receiving fax machine.

The fax received by the recipient is
blank.

The document was loaded
incorrectly.

• Document feeder: Place the
original document face up.

• Document glass: Place the
original document face down.

Fax was not transmitted. The fax number is wrong. Verify the fax number.

The telephone line is incorrectly
connected.

Verify the telephone line
connection. If it is disconnected,
connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax is not installed or is not
enabled.

Verify that the fax is installed and
enabled.
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Symptoms Causes Solutions

Server Fax is enabled. Ensure that Server Fax is disabled.

If the problem persists, for online support information, go to:

• www.xerox.com/office/WC3335support

• www.xerox.com/office/WC3345support

PPrroobblleemmss RReecceeiivviinngg FFaaxxeess

Symptoms Causes Solutions

The received fax is blank. There is a problem with the
telephone connection or with the
fax machine of the caller.

Verify that the printer can make
clean copies. If it can,request the
caller resend the fax.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call, but
does not accept incoming data.

Not enough memory. If the job contains several
graphics, the printer may not have
enough memory. The printer does
not answer if memory is low.
Delete stored documents and jobs
then wait for the existing job to
complete. This increases available
memory.

The received fax size is reduced. The paper supply in the printer
does not match the document size
sent.

Confirm the original size of the
documents. Documents can be
reduced based on the available
paper supply in the printer.

Faxes cannot be received
automatically.

The printer is set to receive faxes
manually.

Set the printer to automatic
reception.

The memory is full. Load paper if it is empty, and then
print the faxes stored in the
memory.

The telephone line is incorrectly
connected.

Verify the telephone line
connection. If it is disconnected,
connect it.

There is a problem with the fax
machine of the sender.

Make a copy to verify that your
printer is operating correctly. If the
copy prints correctly, request the
recipient to verify that the fax
machine is operating correctly.
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If the problem persists, for online support information, go to:

• www.xerox.com/office/WC3335support

• www.xerox.com/office/WC3345support
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Getting Help
Xerox provides several automatic diagnostic utilities to help you maintain printer productivity and
print quality.

CCoonnttrrooll PPaanneell MMeessssaaggeess
The printer control panel provides information and troubleshooting help. When a fault or warning
condition occurs, the control panel displays a message informing you of the problem. In many cases,
the control panel also displays an animated graphic showing the location of the problem, such as the
location of a paper jam. For many status and warning messages, the control panel Help provides
additional information.

CCoonnttrrooll PPaanneell HHeellpp
To view more information about error or status messages on the control panel, touch the Help button.

The control panel menu items also have associated help text that describes the menu item.
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VViieewwiinngg WWaarrnniinngg MMeessssaaggeess oonn tthhee CCoonnttrrooll PPaanneell
When a warning condition occurs, a message appears on the control panel to inform you of the
problem. Warning messages inform you about printer conditions, such as low supplies or open doors,
that require your attention. If more than one warning condition occurs, only one appears on the
control panel.

VViieewwiinngg EErrrroorr aanndd AAlleerrtt MMeessssaaggeess oonn tthhee CCoonnttrrooll PPaanneell
When an error condition occurs, a message appears on the control panel to inform you of the
problem. Error messages warn you about printer conditions that prevent the printer from printing or
degrade printing performance. If more than one error occurs, only one is displayed on the control
panel.

To view a list of the current errors on the control panel:

1. Press the Machine Status button, then touch the Active Messages tab.

2. Touch the Faults and Alerts menu, then choose an option.
• Faults: This menu shows the error messages that affect the operation of the printer and the

corresponding fault codes.
• Alerts: This menu shows alert messages regarding the current job status of the printer and

the corresponding alert codes.

VViieewwiinngg JJoobb SSttaattuuss oonn tthhee CCoonnttrrooll PPaanneell
To view current or saved jobs on the control panel:

1. At the control panel, press the Job Status button.

2. To view a list of active jobs, touch Active Jobs.

3. To view a list of personal and secure jobs, touch Personal & Secure Jobs.

4. To view a list of completed jobs, touch Completed Jobs.

UUssiinngg tthhee IInntteeggrraatteedd TTrroouubblleesshhoooottiinngg TToooollss
Your printer has a printable set of reports. Two of them, the Demo Page and the Error Message
Report, can help with troubleshooting certain problems. The Demo Page prints an image to show the
current ability of the printer to print. The Error Message Report prints information on the most recent
printer errors.

AAcccceessssiinngg aanndd PPrriinnttiinngg tthhee IInnffoorrmmaattiioonn PPaaggeess
To access the full list of information pages for your printer:
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1. At the printer control panel, press the Help button.

A list of information pages that you can print appears.

2. To scroll through the list of available pages, touch and drag your finger up or down on the menu.
Touch the desired page, then touch Print.

Note: To print all of the information pages, at the bottom of the list, touch All Information
Pages, then touch Print.

3. To return to the Home screen, touch (X).

SSeettttiinngg AAcccceessss RRiigghhttss ffoorr tthhee CCoonnffiigguurraattiioonn RReeppoorrtt aanndd
IInnffoorrmmaattiioonn PPaaggeess
Use the following procedures to prevent the Configuration Report from printing automatically
whenever the device powers on, or to the change access rights for the Configuration Report and
Information Pages.

1. At the printer control panel, press the Machine Status button, then touch the Tools tab.

2. Touch Device Settings→Information Pages.

Note: If this feature does not appear, log in as a system administrator. For details, refer to
the System Administration Guide at:

• WorkCentre® 3335: www.xerox.com/office/WC3335docs

• WorkCentre® 3345: www.xerox.com/office/WC3345docs

3. Choose one of the following:
• To restrict users from printing the Information Pages, touch System Administrator Only.
• To allow all users access, touch All Users.

4. Touch OK.

AAvvaaiillaabbllee IInnffoorrmmaattiioonn PPaaggeess
Information pages provide important details to help you troubleshoot issues or analyze printer use.
You can print information pages from the printer control panel.

Information Page Description

Configuration Report The Configuration Report provides product
information including, installed options, network
settings, port setup, tray information, and more.

Customer Assistance Report The Customer Assistance Report provides a summary
of relevant information that you can provide to a
Xerox support representative when you call for
assistance.

Demo Page The Demo page provides a demonstration of the
current print quality.

Supplies Usage Report Prints the supplies information page.
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Information Page Description

Email Sent Report The Email Sent Report provides a record of emails
sent, including From, To, Date & Time, Subject, and
Result.

Error Message Report The Error Message Report provides a record of errors,
including fault and alert codes and date and time of
the error.

Fax Broadcast Report The Fax Broadcast Report provides a record of
broadcast faxes, including total pages scanned,
remote station, start time, and result.

Fax Options Report The Fax Options Report displays the current fax
settings.

Fax Phone Book The Fax Phone Book displays a list of names and fax
numbers.

Fax Protocol Report The Fax Protocol Report provides fax control field
data, fax information field data, and Send/Receive
information.

Fax Receive Report The Fax Receive Report provides a record of faxes
received.

Fax Transmission Report The Fax Transmission Report provides a record of
faxes sent.

Group Address Book The Group Address Book displays contents of the
Group Address Book, including group number, group
name, user name, and email address.

Junk Fax Report The Junk Fax Report displays a record of junk faxes
received and the numbers from which they were sent.

Last 40 Error Messages Report The Last 40 Error Messages Report is a log of the last
40 error messages, with number, code, name, date,
and time.

Email address book The Email Address Book displays contents of the
email address book.

Pending Jobs Report The Pending Jobs Report provides a record of
pending outbound and inbound jobs.

User Authentication Report The User Authentication Report provides a list of
authenticated users and login IDs.

For information on how to print information pages, refer to Accessing and Printing the Information
Pages.

OOnnlliinnee SSuuppppoorrtt AAssssiissttaanntt
The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help
to solve your printer problems. You can find solutions for print-quality problems, paper jams, software
installation issues, and more.

To access the Online Support Assistant, go to:
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• www.xerox.com/office/WC3335support

• www.xerox.com/office/WC3345support

MMoorree IInnffoorrmmaattiioonn
You can obtain more information about your printer from these sources:

Resource Location

Installation guide
The installation guide is packaged with the printer. To
download the installation guide for your printer, select the
link::

• www.xerox.com/office/WC3335docs
• www.xerox.com/office/WC3345docs

Other documentation for your printer • www.xerox.com/office/WC3335docs
• www.xerox.com/office/WC3345docs

Technical support information for your printer,
including online technical support, Online
Support Assistant, and driver downloads.

• www.xerox.com/office/WC3335support
• www.xerox.com/office/WC3345support

Information pages
At the printer control panel, press Help.

In Xerox® CentreWare® Internet Services, click
Properties→General Setup→Configuration→Print System
Data List.

Xerox® CentreWare® Internet Services
documentation

In Xerox® CentreWare® Internet Services, click Help.

Order supplies for your printer • www.xerox.com/office/WC3335supplies
• www.xerox.com/office/WC3345supplies

A resource for tools and information, including
interactive tutorials, printing templates,
helpful tips, and customized features to meet
your individual needs.

www.xerox.com/office/businessresourcecenter

Local sales and support center • WorkCentre® 3335: www.xerox.com/office/worldcontacts
• WorkCentre® 3345: www.xerox.com/office/worldcontacts

Printer registration • WorkCentre® 3335: www.xerox.com/office/register
• WorkCentre® 3345: www.xerox.com/office/register

Xerox® Direct online store www.direct.xerox.com/
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Printer Configurations and Options

AAvvaaiillaabbllee CCoonnffiigguurraattiioonnss
This printer is available in the following configurations:

• WorkCentre® 3335: This configuration is a network printer and includes the following features and
options:

– Copy

– Print

– Scan

– Fax

– Automatic Document Feeder (ADF)

– 50-sheet bypass tray

– Tray 1 with 250-sheet capacity

– Optional tray 2 with 550-sheet capacity

• WorkCentre® 3345: This configuration is a network printer and includes the following features and
options:

– Copy

– Print

– Scan

– Fax

– Reversing Automatic Document Feeder (RADF)

– 50-sheet bypass tray

– Tray 1 with 250-sheet capacity

– Optional tray 2 with 550-sheet capacity

SSttaannddaarrdd FFeeaattuurreess
Print speed WorkCentre® 3335 Printer:

• Letter (8.5 x 11 in.): Maximum 35 prints-per-minute (ppm)
• A4: Maximum 33 ppm

WorkCentre® 3345 Printer:

• Letter (8.5 x 11 in.): Maximum 42 ppm
• A4: Maximum 40 ppm

2-Sided print speed WorkCentre® 3335 Printer:

• Letter (8.5 x 11 in.): Maximum 17 ppm
• A4: Maximum 16 ppm

WorkCentre® 3345 Printer:
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• Letter (8.5 x 11 in.): Maximum 21 ppm
• A4: Maximum 20 ppm

Print resolution • Standard print-quality mode: 600 x 600 dpi
• Enhanced print-quality mode: 1200 x 1200 dpi

Standard Memory (DRAM) 1.5 Gbytes

Flash Memory (ROM) 512 Mbytes

Storage 3-Gbyte internal hard drive

Paper capacity • Bypass tray: 50-sheet capacity
• Tray 1: 250-sheet capacity
• Optional Tray 2: 550-sheet capacity

Maximum print size
Legal: 216 x 356 mm (8.5 x 14 in.)

2-Sided Printing Standard

Copy speed
1-Sided copy:
• WorkCentre® 3335 Printer: 30 copies per minute
• WorkCentre® 3345 Printer: 40 copies per minute

2-Sided copy:

• WorkCentre® 3335 Printer: 12 copies per minute
• WorkCentre® 3345 Printer: 12 copies per minute

These specifications are for Single Document, Multiple Copy
(SDMC)

Copy resolution 600 x 600 dpi

Maximum copy size Legal 216 x 356 mm (8.5 x 14 in.)

Document feeder • WorkCentre® 3335 Printer: Automatic Document Feeder
• WorkCentre® 3345 Printer: Reversing Automatic Document

Feeder

Document feeder capacity 50 sheets

Scan resolution •

Optical: 600 x 600 dpi

•

Enhanced: Up to 4800 x 4800 dpi

Supported scanning • USB
• Email
• Computer

Maximum scan size • Document Glass: 216 x 297 mm (8.5 x 11.7 in.)
• Document Feeder: 216 x 356 mm (8.5 x 14 in.)
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Email and scan file formats • JPEG
• TIFF
• PDF
• XPS

Control panel 109 mm (4.3 in.) LCD touch screen and keypad navigation

Connectivity • Universal Serial Bus: USB 2.0
• USB Flash drive
• Ethernet 10/100/1000 Base-T
• Wireless
• WiFi
• Mopria
• AirPrint

Remote Access Xerox® CentreWare® Internet Services
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Physical Specifications

WWoorrkkCCeennttrree®® 33333355 PPrriinntteerr CCoonnffiigguurraattiioonn WWeeiigghhttss
aanndd DDiimmeennssiioonnss

Standard Configuration with
Tray 1 only

Optional Configuration with Tray 1 and
Tray 2

Width 41.5 cm (16.3 in.) 41.5 cm (16.3 in.)

Depth 42.1 cm (16.6 in.) 47.7 cm (18.80 in.)

Height 45.0 cm (17.7 in.) 59.4 cm (23.4 in.)

Weight 15.54 kg (34.26 lb.) 21.06 kg (46.44 lb.)

WWoorrkkCCeennttrree®® 33334455 PPrriinntteerr CCoonnffiigguurraattiioonn WWeeiigghhttss
aanndd DDiimmeennssiioonnss

Standard Configuration with
Tray 1 only

Optional Configuration with Tray 1 and
Tray 2

Width 46.9 cm (18.5 in.) 46.9 cm (18.5 in.)

Depth 44.4 cm (17.5 in.) 50.0 cm (19.7 in.)

Height 48.2 cm (19.0 in.) 62.5 cm (24.5 in.)

Weight 17.34 kg (38.23 lb.) 22.9 kg (50.41 lb.)
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PPhhyyssiiccaall SSppeecciiffiiccaattiioonnss ffoorr WWoorrkkCCeennttrree®® 33333355
SSttaannddaarrdd CCoonnffiigguurraattiioonn
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PPhhyyssiiccaall SSppeecciiffiiccaattiioonnss ffoorr WWoorrkkCCeennttrree®® 33334455
SSttaannddaarrdd CCoonnffiigguurraattiioonn
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CClleeaarraannccee RReeqquuiirreemmeennttss ffoorr SSttaannddaarrdd CCoonnffiigguurraattiioonn
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Environmental Specifications

TTeemmppeerraattuurree
• Optimum Temperature: 16–30°C (61–86°F)

• Storage Temperature: from –20 through 40°C (from –4 through 104°F)

RReellaattiivvee HHuummiiddiittyy
Minimum–Maximum Humidity Range: 10–90%, less than 90% when in the packaging

• Optimum Humidity: 30–70%

• Operating Humidity: 20–80% Relative Humidity

Note: Under extreme environmental conditions, such as 10°C (50°F) and 85% relative
humidity, defects can occur due to condensation.

EElleevvaattiioonn
For optimum performance, use the printer at elevations below 2500 m (8,202 ft.).
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Electrical Specifications

PPoowweerr SSuuppppllyy VVoollttaaggee aanndd FFrreeqquueennccyy
Power Supply Voltage Power Supply Frequency

110–127 VAC +/-10%, (99–135 VAC) 50 Hz

60 Hz

220–240 VAC +/-10%, (198–264 VAC) 50 Hz

60 Hz

PPoowweerr CCoonnssuummppttiioonn
• Energy Saver Mode (Sleep): Less than 3.5W

• Continuous printing: Less than 700W

• Ready/Standby: Less than 50W

This printer does not consume electric power when the power switch is turned off even if the printer is
connected to an AC outlet.
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Performance Specifications

PPrriinntt WWaarrmm--uupp TTiimmee
• Power on:

• Recovery from Sleep Mode:

PPrriinntt SSppeeeedd
• WorkCentre® 3335: up to 35 ppm for Letter and 33 ppm for A4.

• WorkCentre® 3345: up to 42 ppm for Letter and 40 ppm for A4.

Several factors affect print speed:

• 2-sided printing:

– WorkCentre® 3335: up to 17 ppm for Letter (8.5 x 11 in.) and 16 ppm for A4 (210 x 297 mm)

–

WorkCentre® 3345: up to 21 ppm for Letter (8.5 x 11 in.) and 20 ppm for A4 (210 x 297 mm)

• Print mode: Standard is the fastest print mode. Enhanced is half speed or slower.

• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed.

• Paper type: Plain paper prints faster than Cardstock or Heavyweight.

• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.
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Basic Regulations
Xerox has tested this printer to electromagnetic emission and immunity standards. These standards
are designed to mitigate interference caused or received by this printer in a typical office
environment.

EENNEERRGGYY SSTTAARR®®QQuuaalliiffiieedd PPrroodduucctt
The WorkCentre® 3345 Printer is ENERGY STAR®qualified under the ENERGY
STAR Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. The
ENERGY STAR Imaging Equipment Program is a team effort between the United States,
European Union, and Japanese governments and the office equipment industry to
promote energy-efficient copiers, printers, fax, multifunction printers, personal computers,
and monitors. Reducing product energy consumption helps combat smog, acid rain, and
long-term changes to the climate by decreasing the emissions that result from
generating electricity.

Xerox ENERGY STAR equipment is preset at the factory. Your printer is delivered with the
timer, for switching to Power Saver Mode from the last copy/print out, set at 1 or 2
minutes.

For a more detailed description of this feature, refer to the Power Saver Mode section of
this guide.

UUnniitteedd SSttaatteess FFCCCC RReegguullaattiioonnss
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in
accordance with these instructions, it may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user
to operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.
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EEuurrooppeeaann UUnniioonn

The CE mark applied to this product symbolizes a declaration of conformity by Xerox
with the following applicable Directives of the European Union as of the dates indicated:
• February 26, 2014: Low Voltage Directive 2014/35/EU
• February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or
for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

EEuurrooppeeaann UUnniioonn LLoott 44 IImmaaggiinngg EEqquuiippmmeenntt
AAggrreeeemmeenntt EEnnvviirroonnmmeennttaall IInnffoorrmmaattiioonn

EEnnvviirroonnmmeennttaall IInnffoorrmmaattiioonn PPrroovviiddiinngg EEnnvviirroonnmmeennttaall SSoolluuttiioonnss aanndd
RReedduucciinngg CCoosstt
The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

• Standard monochrome format products with a maximum speed less than 66 A4 images per
minute

• Standard color format products with a maximum speed less than 51 A4 images per minute

Introduction
The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

• Standard monochrome format products with a maximum speed less than 66 A4 images per
minute

• Standard color format products with a maximum speed less than 51 A4 images per minute

Environmental Benefits of Duplex Printing
Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires
that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm
monochrome the duplex function has been auto enabled, during the setup and driver installation.
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Some Xerox models below these speed bands may also be enabled with 2-sided printing settings
defaulted on at the time of install. Continuing to use the duplex function will reduce the
environmental impact of your work. However, should you require simplex/1-sided printing, you may
change the print settings in the print driver.

Paper Types
This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight
paper (60 g/m²), which contains less raw material and thus save resources per print, may be used in
certain applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR (European Union Information)
The ENERGY STAR program is a voluntary scheme to promote the development and purchase of
energy efficient models, which help to reduce environmental impact. Details on the ENERGY STAR
program and models qualified to ENERGY STAR can be found at the following website: www.
energystar.gov/find_a_product

Power Consumption and Activation Time
The amount of electricity a product consumes depends on the way the device is used. This product is
designed and configured to enable you to reduce your electricity costs. After the last print, the device
switches to Ready mode. In this mode, the device can print again immediately. If the product is not
used for a period of time, the device switches to a Power Saver mode. In these modes, to enable
reduced product power consumption, only essential functions remain active.

The product takes slightly longer to produce the first print after it exits Power Saver mode than it
takes in Ready mode. This delay is the result of the system waking up from Power Saver mode and is
typical of most imaging products on the market.

You can set a longer activation time or completely deactivate the Power Saver mode. This device can
take longer to switch to a lower energy level.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/about-
xerox/environment/enus.html .

Environmental Choice Certified to Office Machines CCD-035

This product is certified to Environmental Choice standard for office
machines, meeting all requirements for reduced environmental impact.
As part of achieving certification, Xerox Corporation has proven this
product meets the Environmental Choice criteria for energy efficiency.
Certified copier, printer, multifunctional device, and fax products must
also meet criteria such as reduced chemical emissions and demonstrate
compatibility with recycled supplies. Environmental Choice was
established in 1988 to help consumers find products and services with
reduced environmental impacts. Environmental Choice is a voluntary,
multi-attribute, and lifecycle-based environmental certification. This
certification indicates that a product has undergone rigorous scientific
testing, exhaustive auditing, or both, to prove its compliance with
stringent, third-party, environmental performance standards.
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GGeerrmmaannyy

GGeerrmmaannyy -- BBlluuee AAnnggeell

RAL, the German Institute for Quality Assurance and Labeling, has
awarded this device the Blue Angel Environmental Label. This label
distinguishes it as a device that satisfies Blue Angel criteria for
environmental acceptability in terms of device design, manufacture,
and operation. For more information, go to: www.blauer-engel.de.

BBlleennddsscchhuuttzz
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.

LLäärrmmeemmiissssiioonn
Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A)
oder weniger gemäß EN ISO 7779.

IImmppoorrtteeuurr
Xerox GmbH

Hellersbergstraße 2-4

41460 Neuss

Deutschland

BBrraassiill
Este produto contém a placa SDGOB-1391 código de homologação ANATEL 01693-03269.

Este equipamento não tem direito à proteção contra interferêrncia prejuidicial e não pode causar
interferência em sistemas devidamente autorizados.

TTuurrkkeeyy RRooHHSS RReegguullaattiioonn
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yönetmeliğine uygundur.”
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RReegguullaattoorryy IInnffoorrmmaattiioonn ffoorr 22..44 GGHHzz WWiirreelleessss NNeettwwoorrkk
AAddaapptteerr
This product contains a 2.4-GHz Wireless LAN radio transmitter module which complies with the
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 99/
5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference
that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void
the user's authority to operate this equipment.
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Copy Regulations

UUnniitteedd SSttaatteess
Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

1. Obligations or Securities of the United States Government, such as:

• Certificates of Indebtedness.

• National Bank Currency.

• Coupons from Bonds.

• Federal Reserve Bank Notes.

• Silver Certificates.

• Gold Certificates.

• United States Bonds.

• Treasury Notes.

• Federal Reserve Notes.

• Fractional Notes.

• Certificates of Deposit.

• Paper Money.

• Bonds and Obligations of certain agencies of the government, such as FHA and so on.

• Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

• Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

• Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75% or more
than 150% of the linear dimensions of the original.

• Postal Money Orders.

• Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

• Stamps and other representatives of value, of whatever denomination, which have been or
may be issued under any Act of Congress.

• Adjusted Compensation Certificates for Veterans of the World Wars.

2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright
law. Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

5. Passports. Foreign Passports may be photographed.

6. Immigration papers.

7. Draft Registration Cards.

8. Selective Service Induction papers that bear any of the following Registrant’s information:

• Earnings or Income.

• Court Record.

• Physical or mental condition.

• Dependency Status.

• Previous military service.

• Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of
the various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered
by the head of such department or bureau).

Reproducing the following is also prohibited in certain states:

• Automobile Licenses.

• Drivers’ Licenses.

• Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In
case of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

CCaannaaddaa
Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

• Current bank notes or current paper money

• Obligations or securities of a government or bank

• Exchequer bill paper or revenue paper

• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or
of a court of law

• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely
cause same to purport to have been printed by the Queens Printer for Canada, or the equivalent
printer for a province)

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of
a province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada
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• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or
of a province or by the government of a state other than Canada

• Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright
or trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

OOtthheerr CCoouunnttrriieess
Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

• Currency notes

• Bank notes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Regulations

UUnniitteedd SSttaatteess

FFaaxx SSeenndd HHeeaaddeerr RReeqquuiirreemmeennttss
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or
other individual sending the message and the telephone number of the sending machine or such
business, other entity, or individual. The telephone number provided may not be a 900 number or any
other number for which charges exceed local or long-distance transmission charges.

DDaattaa CCoouupplleerr IInnffoorrmmaattiioonn
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAFA##BXXXX. If
requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It connects to a compatible modular
jack that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not
ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed
five (5.0). To be certain of the number of devices that can be connected to a line, as determined by
the RENs, contact the local Telephone Company. For products approved after July 23, 2001, the REN
is part of the product identifier that has the format US:AAAFA##BXXXX. The digits represented by ##
are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is
separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the
codes in the following list:

• Facility Interface Code (FIC) = 02LS2

• Service Order Code (SOC) = 9.0Y

Caution: Ask your local Telephone Company for the modular jack type installed on your line.
Connecting this machine to an unauthorized jack can damage telephone company equipment.
You, not Xerox, assume all responsibility and/or liability for any damage caused by the
connection of this machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the
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Telephone Company interrupts your service, they can advise you of your right to file a complaint with
the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could
affect the operation of the equipment. If the Telephone Company changes something that affects
the operation of the equipment, they should notify you in order for you to make necessary
modifications to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center
for repair or warranty information. Contact information is contained in the Machine Status menu on
the printer and in the back of the Troubleshooting section of the User Guide. If the equipment is
causing harm to the telephone network, the Telephone Company may request you to disconnect the
equipment until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make
repairs to the printer. This applies at any time during or after the service warranty period. If
unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state
tariffs. Contact the state public utility commission, public service commission, or corporation
commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure
that the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company
or a qualified installer.

CCaannaaddaa
This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs
or alterations made by the user to this device, or device malfunctions, could cause the
telecommunications company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections
of the power utility, telephone lines, and internal metallic water pipe systems, if present, must be
connected together. This precaution could be vital in rural areas.

WARNING: Do not attempt to make such connections yourself. Contact the appropriate
electric inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of
terminals allowed to be connected to a telephone interface. The termination on an interface could
consist of any combination of devices. The only limitation to the number of devices is the requirement
that the sum of the RENs of the devices does not exceed 5. For the Canadian REN value, please see
the label on the equipment.
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EEuurrooppeeaann UUnniioonn

RRaaddiioo EEqquuiippmmeenntt aanndd TTeelleeccoommmmuunniiccaattiioonnss TTeerrmmiinnaall EEqquuiippmmeenntt
DDiirreeccttiivvee
The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-
European single terminal connection to the public switched telephone network (PSTN). However, due
to differences between the individual PSTNs provided in different countries, the approval does not
give an unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for
terminal equipment for use on analog-switched telephone networks in the European Economic Area.
This product provides a user-adjustable setting of the country code. The country code should be set
prior to connecting this product to the network. Refer to the customer documentation for the
procedure for setting the country code.

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling,
we recommend that you set it to use DTMF signaling for more reliable and faster call setup.
Modification of this product, connection to external control software, or connection to an
external control apparatus not authorized by Xerox ® will invalidate its certification.

SSoouutthh AAffrriiccaa
This modem must be used in conjunction with an approved surge protection device.

NNeeww ZZeeaallaanndd
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has

accepted that the item complies with minimum conditions for connection to its network. It
indicates no endorsement of the product by Telecom, it does not provide any sort of warranty,
and it does not imply that any Telepermitted product is compatible with all Telecom network
services. Above all, it provides no assurance that any item will work correctly in all respects with
another item of Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
33.6kbps and 56kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in
such circumstances.

2. Immediately disconnect this equipment should it become physically damaged, then arrange for
its disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom
customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There
is no guarantee that Telecom lines will always continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such
problems, do not contact the Telecom Faults Service.
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6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

WARNING: No '111' or other calls can be made from this device during a mains power
failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected
to the same line.

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent
on the equipment (computer) associated with this device. The associated equipment shall be set
to operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

• There shall be no more than 10 call attempts to the same number within any 30 minute
period for any single manual call initiation, and

• For automatic calls to different numbers:

• The equipment shall be set to ensure that automatic calls to different numbers are spaced
such that there is no less than five seconds between the end of one call attempt and the
beginning of another.

9. For correct operation, total of the RNs of all devices connected to a single line at any time should
not exceed five.
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Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to:

• North America:

– WorkCentre® 3335: www.xerox.com/msds

– WorkCentre® 3345: www.xerox.com/msds

• European Union:

– WorkCentre® 3335: www.xerox.com/environment_europe

– WorkCentre® 3345: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to:

• WorkCentre® 3335: www.xerox.com/office/worldcontacts

• WorkCentre® 3345: www.xerox.com/office/worldcontacts

.
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All Countries
If you are managing the disposal of your Xerox product, please note that the printer may contain
lead, mercury, perchlorate, and other materials whose disposal may be regulated due to
environmental considerations. The presence of these materials is fully consistent with global
regulations applicable at the time that the product was placed on the market. For recycling and
disposal information, contact your local authorities. Perchlorate Material: This product may contain
one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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North America
Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox
representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more
information about Xerox environmental programs, visit www.xerox.com/environment for WorkCentre®
3335 or www.xerox.com/environment for WorkCentre® 3345, or for recycling and disposal
information, contact your local authorities.
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European Union
Some equipment may be used in both a domestic/household and a professional/business application.

DDoommeessttiicc//HHoouusseehhoolldd EEnnvviirroonnmmeenntt
Application of this symbol on your equipment is confirmation that you should not
dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end-of-life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to
take back your old equipment free of charge. Please ask your retailer for information.

PPrrooffeessssiioonnaall//BBuussiinneessss EEnnvviirroonnmmeenntt
Application of this symbol on your equipment is confirmation that you must dispose
of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end-of-life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end-of-life take-back
information.

CCoolllleeccttiioonn aanndd DDiissppoossaall ooff EEqquuiippmmeenntt aanndd BBaatttteerriieess

• These symbols on the products and/or accompanying documents mean that used electrical
and electronic products and batteries should not be mixed with general household waste.

• For proper treatment, recovery, and recycling of old products and used batteries, please
take them to applicable collection points, in accordance with your national legislation and
the Directive 2002/96/EC and 2006/66/EC.

• By disposing of these products and batteries correctly, you will help to save valuable
resources and prevent any potential negative effects on human health and the
environment which could otherwise arise from inappropriate waste handling.

• For more information about collection and recycling of old products and batteries, please
contact your local municipality, your waste disposal service, or the point of sale where you
purchased the items.

• Penalties may be applicable for incorrect disposal of this waste, in accordance with national
legislation.
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BBuussiinneessss UUsseerrss iinn tthhee EEuurrooppeeaann UUnniioonn
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.

DDiissppoossaall OOuuttssiiddee ooff tthhee EEuurrooppeeaann UUnniioonn
These symbols are only valid in the European Union. If you wish to discard these items, please
contact your local authorities or dealer and ask for the correct method of disposal.

BBaatttteerryy SSyymmbbooll NNoottee

This wheeled-bin symbol may be used in combination with a chemical symbol. This
establishes compliance with the requirements set out by the Directive.

BBaatttteerryy RReemmoovvaall
Batteries should only be replaced by a manufacturer-approved service facility.
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Other Countries
Please contact your local waste management authority to request disposal guidance.
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